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Preface
This manual presents installation and configuration information for the network
computers. This manual is written for system and network administrators
responsible for installing network computers in a distributed-computing
environment. The procedures in this manual assume you are familiar with:
•

the operating system and administration of the intended host computer

•

the network protocols and concepts related to your local-area network
(LAN)

•

the X environment, including window managers and display managers

The following conventions and terminology is used in this manual.
•

Pointing: use the mouse to position the pointer on an object on the display

•

Moving: use the mouse to change the location of the pointer on the display

•

Clicking: press and release a mouse button without moving the pointer

•

Dragging: press and hold down a mouse button while moving the pointer

•

Releasing: release the mouse button to complete a dragging action

Related Documentation
Network Computer Installation for UNIX — 9300845
Network Computer Installation for VMS — 9300846
Serial Xpress User — 9300834
The following documents are on the CD ROM included with NCBridge:
Network Computer Reference
Network Computer User
3270/3179G User
3270E/5250 User
In addition, System or Network Administration manuals for your computer are
also helpful for information such as subnet mask, and broadcast addresses.
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Figure 1 Typographical Conventions.
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Pieces of the Puzzle
Configuration is the key to the successful integration of network computers into
your environment. System configuration is represented as a puzzle: each piece
must be completed and integrated before the entire system configuration is
complete. The configuration puzzle is illustrated in Figure 2.
Throughout this manual, the individual puzzle pieces are used to visually guide
you through the system configuration process. As you complete each piece, you
are one step closer to a centralized system. When the puzzle is complete, you
have created a custom environment tailored to your computing resources, your
applications, and your users’ requirements. As an added bonus, the system is
centrally administered, easy to maintain, and has the flexibility to adapt to your
changing computing needs.
Chapter 1, Installing the Software, is the first step in the configuration
process. This chapter describes how to load the network computer
software onto your computer.
Chapter 2, Making Choices, helps you analyze your environment and
select the best methods to configure your network computers and your
environment. Strategies for using a centralized configuration, integrating
additional network computers, and using Flash memory are also
included.
Chapter 3, Supporting a Centralized System, provides the host specific
procedures you need to implement your configuration decisions you
made in Chapter 2. Refer to Chapter 2 for information on which
procedures to perform.
Chapter 4, Local Clients, provides information about starting and using
the XpressWare local clients. Local clients execute on the network
computer instead of the host, thus reducing network traffic.
Chapter 5, Window Managers, provides information about the local
window managers; Motif Window Manager, OpenLook Window
Manager, and XpressWare Window Manager.
Chapter 6, Using Additional Fonts, describes the procedures and utilities
necessary to make your fonts available to the network computer.
Chapter 7, Troubleshooting, describes debugging methods and solutions
to help troubleshoot your configuration.
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Figure 2 The System Configuration Process

viii

Windows NT Installation

Chapter

1

Installing the Software

The first step is to install the network computer software on one or more hosts.
The network computer plugs directly into the network, so you can install the
software on one host or distribute it across different hosts on the same network.
The media contains all of the files you need to boot and configure your network
computers. With SETUP.EXE, you can install everything or select only the files
you need for your environment.
NOTE: You must be logged in as administrator to perform an
installation. Refer to your NT documentation for information on
setting up the administrator account to preserve file permissions. The
administrator should have read, write, and execute privileges, but
others only have read and execute.
This manual provides detailed installation information but first, a quick-start list
is provided as an overview. It is also useful for experienced users who don’t
need a lot of detail.
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Quick Start
The following steps provide an overview describing how to install NCBridge
on the host and to configure an NC for operation. Details can be found in the
remainder of this manual. Also see the Network Computer Reference Manual
for more information.

NCBridge installation
1. Log on to installation host.
2. Double-click on the "My Computer" icon on the desktop. An icon
representing the CD-ROM should be present.
3. Insert the CD-ROM with the NCBridge software into the drive of the host.
4. The NCBridge installation wizard should begin to run. If not, select
View->Refresh and then double-click the NCBridge CD icon.
Follow the on-screen instructions for installation.

NC terminal installation
1. Unpack the NC hardware and assemble according to Installation Guide
provided.
2. Turn on the NC.
3. When the boot screen appears, press the spacebar.
4. Set the following items:
IA <ip address of NC>
IH <ip address of boot host>
IM <subnet mask>
BP </installation_directory/tekxp/boot/os.500>
IGate <ip address of gateway host>
NVS (to save settings in NVRAM)
B (to start boot process)
The network computer should boot for basic operation. Make custom changes
to the installation, as desired.
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Media Contents
The directory hierarchy is created relative to the current directory. For example,
if you are at the root partition (\), the directory tekxp is created. Throughout the
manuals, the install directory is assumed to be tekxp. Here are the tekxp
directories:
• tekxp\bin\nt Contains network computer utilities for the NT environment.
• tekxp\boot Contains boot files, fonts and clients. Files that differ between
models use a .model suffix. Refer to Table 1-1 for model information.
• tekxp\boot\config Contains the network computer configuration files.
• tekxp\boot\fonts Contains the supplied non-resident fonts.
• tekxp\boot\<language_directory>\app-defaults Contains translated text for
network computer clients.
• tekxp\examples Contains examples such as Xsession and bootptab.
• tekxp\man\nt Contains man pages for many of the included utilities.
• tekxp\mgmt Contains a sample SNMP MIB file.

Windows NT Installation
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Running SETUP.EXE
These steps tell you how to perform a basic installation of the NCBridge
software on the Windows NT host. For details about customizing the software,
refer to the Network Computer Reference Manual, supplied on the CD-ROM.

Getting Started
1. Log in to the NT host on which you will install the NCBridge software.
2. Open the "My Computer" icon by double-clicking it. This displays icons
representing system resources, including the CD-ROM.
3. Insert the NCBridge CD-ROM into the drive. The CD- ROM device icon
should be replaced by the NCBridge icon (the drive label should say
'NCBRIDGE_VERSION_ 3_2') and the installation wizard should begin. If
this is not the case (and the NCBridge installation program does not start),
select View => Refresh and double-click the NCBridge icon.
4. When the install programs executes, the NCBridge splash screen will appear
and the install wizard software will load. The user will be presented with a
'Welcome' dialog box. Click the 'Next' button on the on the 'Welcome' dialog
to proceed. Click the 'Cancel' button at any time to abort the installation.

Setting the Installation Path
When the installation process begins, "Choose Destination Location" dialog
box, show in Figure 1-1, will appear. The "Choose Destination Location"
dialog box allows the user to set the desired installation path. By default this
path is C:\NCBridge or the existing NCBridge installation path. Clicking
the "Browse" button will bring up a file selector, shown in Figure 1-2, to help
navigate though your file system for a suitable destination location. Once the
destination folder is set, click the 'Next' button to proceed. The user can revisit
previous install dialogs by clicking the 'Back' button.
If you have a current installation, your configuration files are saved for you. Be
sure to check the new configuration files for any new commands, and add any
applicable commands to your saved configuration files.
NOTE: If you change the destination folder for installation, ensure the new
path matches the Secure Read directory specified by the NCD TFTP applet,
displayed in the Control Panel.
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Setting the Installation Path

If there is a previous installation in the current directory, the configuration files
(.cnf and .tbl files) are preserved. The new configuration files are stored in the
directory tekxp/config_date where date is the format YMDHMS.

Figure 1-1. "Choose Destination" Dialog Box

Figure 1-2. Selecting an Alternate Installation Location

Windows NT Installation
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Selecting Installation Options
In the "Setup Type" dialog box, the user can choose between three software
installation options, shown in Figure 1-3:
• Typical — Program will be installed with the most common options.
Recommended for most users.
• Compact — Quickly installs only those files necessary to boot and
configure NCD network computers. These include the network computer
boot files and configuration files. This is good for upgrading existing
NCBridge installations.
• Custom — You may choose specific packages for installation. This is
recommended for advanced users. This installs only the options you select.
By default, all options are pre-selected. To make your selection, click the
"Custom" radio button and click the "Next" button to access the "Select
Components" dialog.

Figure 1-3. "Installation Options" Dialog Box

Unless you have selected the "Custom" install, clicking the "Next" button will
start the transfer of NCBridge software from the CD-ROM to the destination
location on the server.
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File Transfer

If you have selected the 'Custom' install option, the "Select Components" dialog,
shown in Figure 1-4, will appear. A list of software components is shown with
check-boxes indicating the desired selections. Some components are comprised
of sub-components which can also be custom configured. Highlight a component
and click the 'Change' button to access sub-component lists. If the 'Change' button
is disabled, then the component you have highlighted does not contain a
configurable sub-component list. After selecting the desired components for
installation, click the 'Next' button to begin the file transfer process.

Figure 1-4. Custom Components Selections

File Transfer
The screen will display three file system status bar meters and a dialog box with a
status bar. The three status meters on the left indicate the transfer status of
individual files, installation completion status, and overall disk usage. The status
bar in the dialog window indicates the percentage of the installation is complete.

Windows NT Installation
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Installation Completion
When file transfer has completed, the "Setup Complete" dialog will appear.
Installation of NCBridge software is now complete. Click the "Finish" button
to exit the NCBridge installation program.
NOTE: NT systems use backslashes (\) in their file paths. The
network computer uses front slashes for internal file paths. When
specifying path entries for the network computer, as in xp.cnf, Setup
and other local clients, use front slashes (/) instead of the normal NT
backslashes. NCBridge software translates between these two types of
slashes as it accesses the NT server.
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Getting Acquainted
This section describes adding the first network computer to your system. It
contains step-by-step procedures for performing a basic network computer
installation. By following the instructions in this section, you become familiar
with the network computer’s network configuration parameters, Boot Monitor,
and Setup utility. In addition to learning about the network computer, the
procedures presented in this section lead you through the basic host
configuration procedures for supporting network computers.
NOTE: If you are familiar with network computers, skip to Chapter
2 for information on integrating network computers into your system.
These steps are performed during the basic network computer installation:
• Configure host files to support the network computer
• Collect information about your environment which is needed to boot the
network computer
• Use the Boot Monitor to enter network computer communication parameters
and establish a host connection
• Log in through a Telnet session from Client Launcher
• Use Setup to enter the network computer configuration parameters
After the basic network computer installation is complete, the network
computer can:
• Locate the host on the network
• Download the operating system, configuration, and font files
• Apply configuration files residing on the host

Windows NT Installation
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Basic Installation
In a distributed computer environment, host computers perform a variety of
functions. The boot_host sends the boot_file to the terminal, allowing it to
function as an X display. The font_host contains the files defining the
appearance of the various character fonts that can be displayed by the network
computer. The network computer needs access to this host frequently in the
course of a user session. The login_host is the host where the user’s login
account is found. The login host supplies a login window to the network
computer, using some utility that provides login services.
Here is an example showing information about a sample environment:
Boot Host:
Boot Host Name:
Network computer model:
Network computer Name:
Netmask:
Gateway Address:
Broadcast Address:
Boot Method:

Compaq Proliant running Windows NT
oregon
IP Address:
128.07.60.01
NC421H
portland
IP Address:
128.07.60.30
255.255.255.0
128.07.60.100
128.07.60.255
tftp

If you are not familiar with the listed terms, consult your Windows NT System
and Network Administration manuals.
For the examples in this section, it is assumed you have loaded NFS on your
Windows NT system, and have enabled a mount point to the network computer
information. Refer to your NFS manual for more information.
NOTE: NT systems use backslashes (\) in their file paths. The
network computer uses front slashes for internal file paths. When
specifying path entries for the network computer, as in xp.cnf, Setup
and other local clients, use front slashes (/) instead of the normal NT
backslashes. NCBridge software translates between these two types of
slashes as it accesses the NT server.
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Network Computer Worksheet
Complete this worksheet prior to powering on the network computer. When
completed, the information on this worksheet assists you in booting the network
computer and performing other procedures.
1. Network computer model: NC_____
Find this information on the network computer’s serial number tag.

2. Network computer hardware address: ____:____:____:____:____:____
Find this information on the network computer’s serial number tag.

3. Network computer name: _____________________
4. Network computer IP address: ____._____._____._____
5. Boot Path: _________________________________boot_directory
(/<boot_directory>/boot/<boot file> For example, /tekxp/boot/os.330)

Use Table 1-1 to determine your boot file.
Table 1-1 Boot Files.
Boot File

Supported Network Computer Series

os.10

XP10 Series (example: XP18)

os-tr.10

XP10 Token Ring Series (example: XP18T)

os.330

XP100D, XP330 Series (example: XP338)

ospex.330

XP338P

os.350

XP100 Series, XP200 Series, XP350 Series, and XP400
Series (examples: XP117C, XP219, XP358)

os.500

NC200 and NC400

os-tr.500

NC with Token Ring Option

6. Boot Method: nfs 8192
7. Subnet mask: ____._____._____._____ ip_subnet_mask
Valid values are: (Class A) 255.0.0.0, (Class B) 255.255.0.0,
or (Class C) 255.255.255.0.

Windows NT Installation
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8. Boot Host:
a. Host name:

_____________

b. Host IP address: IP address: _____._____._____._____
9. Gateway on the network computer’s subnet: ____.____.____.____
NOTE: Steps 10, 11, and 12 are only used when adding an
network computer to a Token-Ring network. If the network computer
does not have a Token-Ring interface, omit these items.
10. Locally-administered address(LAA): ____:____:____:____:____:____
11. Maximum Transmission Unit (MTU): ______ number
Sets a maximum length of the information field of the frame. Valid numbers are: 516
or 1500 or 2052 or 4472 or 8144 or 11407 or 17800. The default is 1500.

12. Lanspeed: ______rate
Valid rates are: 4 or 16 (Mbps).
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Configuring Host Files
The following host utility is configured for this example:
• nfs (Network File Service) to provide booting service

Enabling NFS Access
NFS is used in this example to download the network computer operating
system, X server, configuration files, and resident fonts.
1. Add the boot_directory (/tekxp/boot) to be exported on the host. Export as
read only. Refer to your NFS documentation for information on the name
and location of the exports file.
2. Edit the \winnt35\system32\drivers\etc\hosts file and add the network
computer name and address.
128.07.60.30

portland

3. To enable the mount point immediately, open the NFS ⇒ NFS Server dialog
box. Click on Exports. Use the Add button to add and verify mount points.
4. Open Main ⇒ Services to verify NFS is running.

Windows NT Installation
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Powering on the Network Computer
Verify the physical installation of the network computer’s cables, power cords,
keyboard, mouse, and network connection with the pictorial installation sheet
included in the packing box.
Turn on the network computer’s power switch. On the first power-up, you must
specify the keyboard you’re using. By default, the North American 101/102 or
VT200 is selected (depending on the connected keyboard). Press Enter or
Return to accept this keyboard. If using a different keyboard or nationality,
press the Spacebar to scroll through the list of available keyboards and press
Enter or Return to select the appropriate keyboard.
After specifying the keyboard, press the Return or Enter key again to display
the BOOT> prompt.
The BOOT> prompt indicates that you are in the Boot Monitor. The Boot
Monitor is a simple, command-line utility that provides an easy way to input
boot commands. These boot commands set the parameters which describe the
network computer in your network environment.
The scoreboard is an area in the upper right-hand corner of the boot screen. At
this time, the scoreboard shows only default values. Use the scoreboard to
verify the entries you make in the steps that follow.
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Booting the Network Computer
To enter a boot command, type the command plus its associated parameter after
the BOOT> prompt. To complete an entry, press Enter. To see a list of the Boot
Monitor commands, type help and press Enter.
NOTE: An “unrecognized command” error message and description
appears on the screen if an invalid command is entered.
The line numbers in the steps refer to lines on the network computer Worksheet
(page 1-11) where you filled in the appropriate information. If you have not
completed the Worksheet, do so now.
Using the Boot Monitor, perform the following steps:
NOTE: The lanspeed, mtu, and localaddr commands are only used
when adding a network computer equipped with a Token-Ring
interface. Skip to Step 4 if you are installing an Ethernet network
computer.
1. Enter the lanspeed command. (See Line 12.)
A Lanspeed setting is required if you are installing the network computer on
a Token-Ring network. There is no automatic default for lanspeed.
Lanspeed can only be entered with the lanspeed command in the Boot
Monitor.
>>>

Disruption to the Token-Ring LAN may occur if you attempt to open
communications with the wrong lanspeed setting.
BOOT> lanspeed rate

2. Enter the mtu command. (See Line 11.)
If the mtu command is not entered, the default setting of 1500 is used. MTU
can also be set in Setup.
BOOT> mtu number

3. Enter the localaddr command. (See Line 10.)
It is not essential that a locally-administered address be set. The localaddr
command is optional.
BOOT> localaddr address

Windows NT Installation
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4. Use the iaddr command to enter the network computer’s ip address. (See
Line 4.)
BOOT> iaddr ip_address

5. Use the bpath command to enter the boot path. (See Line 5.)
BOOT> bpath /<boot_directory>/boot/os.<model>

6. Use the imask command to enter the subnet mask. (See Line 7.)
BOOT> imask ip_subnet_mask

7. Use the ihost command to enter the boot host’s ip address. (See Line 8b.)
BOOT> ihost ip_address

8. Use the igate command to enter the ip address for a gateway host if the
network computer is booting through a gateway. (See Line 9.)
BOOT> igate ip_address

9. Use the bmethod command to specify NFS as the boot method. The 8192
parameter represents an NFS read size.
BOOT> bmethod tftp

NOTE: Check the scoreboard to verify your entries. If there is an
error, re-enter the command using the correct value.
10. Use the nvsave command to save the values in nonvolatile memory.
BOOT> nvsave

11. Use the boot command to initiate the boot process.
BOOT> boot

If the network computer locates the host and boot files, a bar appears on the boot
screen showing the percent of download complete. Once the network computer
downloads all of the files required, a gray screen with an X-shaped cursor
appears. If the boot process fails without error messages, you probably entered
an incorrect parameter. Enter the appropriate command and parameter to
correct the error. After correcting the error, execute the nvsave and boot
commands. If booting fails again, refer to Chapter 7: Troubleshooting.
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The TekHostMenu client appears. The network computer broadcasts XDMCP
requests to all hosts on its subnet by default. All hosts that respond to the
XDMCP broadcasts appear on this list. If you set up xdm on your host according
to the instructions presented earlier in this chapter, the host should be listed on
the TekHostMenu list.

Figure 1-5 Example TekHostMenu.
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Starting a Session with Launcher
Client Launcher is used to start local clients by selecting a client from a menu.
An arrow to the right of a Client Launcher entry indicates a submenu that
contains additional local clients. In Figure 1-3, selecting Host Connections
displays a sub-menu listing available connections, such as Telnet or WinDD.

Figure 1-6
Launcher

Example Client Launcher.

• Press the Setup key to bring up the Client Launcher. The symbol in the left
margin indicates a Launcher menu selection. If the Launcher is not present,
press the Setup key or key sequence for your keyboard.
Table 1-2 Setup Key and Key Sequences.
Keyboard Type

Press

101/102 with Setup

Setup key

101/102 with Pause

SHIFT-Pause

Sun keyboard

ALT-GRAPH-HELP

3270 keyboard

Right ALT-ExSel (The left ALT key does not work)

LK401

F3 key

UNIX keyboard

Alt-Graph

You can customize the Launcher client for your users through the
system.launcher file. Refer to the Using the Client Launcher section in the
Local Clients chapter.
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Opening a Telnet Session
Telnet provides a direct connection from the network computer to a host
computer. When Telnet is running, the network computer acts as a standard
VT102 terminal.
To open a Telnet session from Launcher:
1. Position the pointer on the Host Connections option to display the submenu.
Select Telnet to open a Telnet window.

Telnet>

Figure 1-7 Telnet Window Waiting for an Open Command.

2. Use the mouse to position the pointer in the Telnet window. You can type h
and press Enter to see a list of Telnet commands.
3. Type:
Telnet> open hostname
where hostname is the name or network address of the host.
Telnet> open oregon

Figure 1-8 Telnet Open Command.
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Once a connection is made (Figure 1-9), you can log in.

Trying...
Connected to 128.07.60.01.
Escape character is ‘^]’

login:

Figure 1-9 Telnet Window with a Host Connection.

4. At the login: prompt, log in to the host computer by entering your user name:
login: user_name
5. At the password: prompt, enter your password:
password: password
Now that you are connected to the host, type the command plus its associated
parameter after the # prompt. To terminate an entry, press Enter.
6. Set the display environment variable for the network computer by entering
the following using the network computer’s IP address:
# setenv DISPLAY <ip_address>
7. If you run a window manager, type your normal command line. In this
example, we are starting the Motif Window Manager.
# mwm &

If your window manager is available, your host environment appears.

Closing a Telnet Window
To close the Telnet window from the Telnet> prompt, type quit and press
Enter. When you are ready to conclude the Telnet session, log out of your host:
# exit

then enter quit to close the Telnet window:
Telnet>
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Using Setup
Setup is a utility where you can add, modify, display, and save network
parameters. Parameters can be saved in NVRAM, or written to a file.
The Setup main menu is illustrated in Figure 1-7. The Setup main menu is made
up of four different areas: Menu Bar, Menu Input, Function Bar, and Message
Box.

Menu
Bar

Menu
Input
Area

Function
Bar
Message
Box

Figure 1-10 The Setup Main Menu.

NOTE: The Setup window on your network computer may look
different from this example based on your network computer model.
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Use the following procedures to enter configuration parameters using Setup.
After each typed entry, press Enter.
1. Drag in the Configuration Summaries menu and release on TCP/IP.
- Enter the following:
Network Computer Name
Default Telnet Host
Name Server 1

network_computer_name
host_ name
ip_address of name server

- Click on Return to Main Menu.
2. Drag in the Configuration Summaries menu and release on
X Environment.
- Select the following:
Host Connect Method

TekHostMenu

- Click on Return to Main Menu.
3. Drag in the Network Tables and Utilities menu and release on NFS Mount.
Click on Add Table Entry.
- Add an entry for each directory exported in the /etc/exports file:
File System Name
Local Directory
Transfer Size

exported directory
local_directory
read size for transferring files

- Click on Return to Main Menu.
4. Drag in the Configuration Summaries menu and release on
Host File Access.
- Select the following:
Primary File Access
Primary Mount Path

NFS
local_directory (from previous step)

- Click on Return to Main Menu.
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5. Drag in the Network Tables and Utilities menu and release on Internet Host.
Click on Add Table Entry.
- Add your boot host and login host as follows:
Host IP Address
Host Name

ip_address
host_name

- Click on Return to Main Menu.
6. Click on Save Current Settings to store the current settings in NVRAM.

Exiting Setup
When you are ready to exit Setup, click on the Exit Setup button.
Once you have successfully completed a basic network computer installation,
go on to Chapter 2 and develop a centralized administration scheme for a
complete network computer installation.
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Hello, wor
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This chapter helps you collect and organize the information you need to create
a centralized system, tailored to your environment. A Workbook is provided to
assist you in this process.
At first glance, the Workbook resembles a tax form, but give it a try. The time
you spend gathering information before you start is far less than the time to
debug configuration later in the installation process. To use this chapter:
• Make a copy of the Workbook (page 2-19 to the end of this chapter). The
Workbook follows the same organization as the remote configuration file
(xp.cnf) to simplify implementing your choices.
• Read through the strategy sections beginning on the next page. The strategy
sections are organized to help you analyze your environment and lead you
through the decision-making process.
• As you make configuration choices, place a check mark on the Workbook
line as directed, then fill in the requested information. Some lines in the
Workbook direct you to other Workbook lines. Place a check mark on the
new line and fill in the information. Whenever possible, entries have been
filled in for you.
• After you complete a Workbook line, return to the strategy text where you
left off.

Windows NT Installation

2-1

Chapter 2

Making Choices

• When the Workbook is complete, continue on to the chapter Supporting a
Centralized System for your host type. Edit the files as needed to incorporate
your configuration choices from the completed Workbook. When you edit a
line in the xp.cnf file, it matches the line in your Workbook.
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Configuration Strategies
System configuration is the key to successfully integrate network computers
into your environment. With proper configuration, you can ensure your users a
smooth transition to network computers with little or no disruption of their
work.
Network computers run efficiently in a distributed-computing environment,
where processing is shared by a number of networked host computers. This
means applications competing for resources at any given time can be distributed
across the system to maximize performance. Files can also be stored and
transferred among the accessible computers to share mass storage resources.
The network computer typically connects directly to the network, so it can
effectively communicate with any host on the network. The network computer
receives files and display information over the network and manages
communications between processes running on the network computer and on
the host.
In a distributed computer environment, host computers perform a variety of
functions. The strategy sections refer to three types of hosts, although in reality
the functions can be as distributed or consolidated as you choose.
A boot host contains the files necessary to boot the network computers. This
includes the model-specific operating system files and xp.cnf file. These files
are downloaded to the network computer via the specified boot method.
A file host contains additional configuration files, fonts, and optional
host-specific utilities for the network computer. The network computer may
frequently access this host during a user session. Files are downloaded to the
network computer via the specified file access method.
A login host is the host where the user’s login account is found. You can specify
a host for each user, or allow the user to select from a list of hosts, depending
on your host connection method. The login host supplies a login window to the
network computer, using a utility that provides login services.
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The strategy sections discuss the basics required to configure and support a
centralized system. To simplify this task, all of the network computer features
are not covered. Once your initial configuration is working, you can enable
additional features as needed.
NOTE: When you add a feature, perform the necessary host
configuration to support the feature. Refer to Chapter 2 of the
Network Computer Reference manual for more information.
These topics are discussed:
• Booting Strategies
- Boot Methods
- Automatic or Manual First Boot
- Subsequent Boots
• File Access Strategies
- File Access Methods
• Host Connection Strategies
• ROM and Flash Memory Strategies
• Boot Host Check List
• Network Computer Check List
• File Host Check List
• What Next?
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Booting Strategies
On a system with many network computers, you might want to install the boot
software on more than one host. Then you can either set up different network
computers to boot and download files from different hosts, or set up all the
network computers to boot from the first available host.

Boot Methods
The network computer uses the boot method to download the X server. Many
of the other booting decisions in this section depend on the boot method you
select. The boot methods are TFTP, NFS, MOP, and ROM.
NOTE: NT systems only support NFS or ROM booting.
• TFTP (Trivial File Transfer Protocol) can be used on TCP/IP networks. It is
not as efficient as NFS, but can be made more secure. TFTP is the default
method to boot network computers not equipped with TDEnet or the Flash
Memory or ROM options.
• NFS (Network File Service) can be used on hosts supporting NFS (typically
in a TCP/IP network). The advantage to NFS is faster booting and increased
efficiency.
• ROM (Read-Only Memory) can be used with network computers equipped
with Flash Memory or a ROM board. ROM is the default method to boot all
network computers equipped with the Flash Memory or the ROM options.
Refer to ROM and Flash Memory Strategies later in this chapter for more
information.
• MOP (Maintenance Operation Protocol) is used on DECnet networks to
download the boot files to the network computers. This is the default boot
method if the network computer is not equipped with Flash Memory or the
ROM options, and if the TDEnet option is enabled on the network computer.
Decide which boot method to use. Continue to the next pages to see how to
implement the method you selected.
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Automatic or Manual First Boot
For a first time boot, the network computers can boot automatically or
manually, depending on how you configure your environment. This decision
does not relate to ROM-based network computers.
Automatic means that the network computer determines boot parameters from
the network and boots without operator intervention. In addition, with
automatic booting you can implement a strategy where network computers can
boot from the first available host.
Manual means that an operator would have to enter the boot parameters before
the network computer could boot.
Implement the manual method if you are installing a single network computer.
Use the Boot Monitor to enter the boot parameters. Implement your other
Workbook selections with the Setup commands. Remember that Setup
commands only affect the individual network computer.
Implement the automatic method if you are installing or planning to install
more than one network computer, or want the network computers to boot from
the first available host. Implement your other Workbook selections with the
xp.cnf commands so they apply to each network computer.
For automatic booting:
If you are going to use TFTP or NFS as the boot method:
Check Workbook line 58 to use bootp (BOOTstrap Protocol) or check
Workbook line 59 to use DHCP for automatic booting. A host that
recognizes the network computer’s hardware address responds with the
following information: the network computer’s Internet address, the boot
server’s Internet address, the name of the file to download, the subnet mask,
and the primary gateway.
If you are going to use MOP as the boot method:
Check Workbook line 65 and Workbook line 66 for automatic booting.
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Subsequent Boots
The next boot decision determines how subsequent boots occur. There are three
main strategies:
• Booting from a specific host, using parameters stored in NVRAM:
- Controls which host is used. In the case of different workgroups on
different hosts, each workgroup can have their own configuration.
- Easier to provide a fixed environment.
- Provides a specific backup (secondary) boot.
• Booting from the first available host, using parameters obtained from the
network:
- The least-busy host responds to the boot requests.
- Provides backup booting. Booting occurs as long as any host is
responding.
• Booting from a specific host, using parameters obtained from the network:
- Controls which host is used. In the case of different workgroups on
different hosts, each workgroup can have their own configuration.
- Easier to administer in a dynamic environment, where network
computers, workgroups, and network addresses tend to migrate.
- Easier to provide a consistent environment.
Decide which strategy to use. Continue to the next page to see how to
implement the strategy you selected.
NOTE: NT systems only support NFS or ROM booting.
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Booting from a specific host, using parameters stored in NVRAM. For this
method, specify all of the required information, change booting to NVRAM,
and save it. You can specify a secondary boot in case the primary boot fails.
The network computer has already booted once. If the current boot parameters
are acceptable, do not change the primary boot information. The network
computer saves the current method, host, and path as the primary.
To change the primary booting information:
Choose the primary boot method to use, either TFTP, NFS, or MOP:
For TFTP, check Workbook line 28.
For NFS, check Workbook line 29.
For MOP, check Workbook line 30.
Check Workbook line 37 to boot from NVRAM instead of NETWORK.
Check Workbook line 42 to save the new method.
To optionally set secondary booting information:
Choose the secondary boot method to use, either TFTP, NFS, or MOP:
For TFTP, check Workbook line 32.
For NFS, check Workbook line 33.
For MOP, check Workbook line 34.
Booting from the first available host, using parameters obtained from the
network. Set up automatic booting (from the previous section) on every boot
host. Add the information for every network computer to every boot host.
- You can explicitly set the boot method but obtain the remainder of the
boot parameters from the network. For example, if you want to boot with
NFS instead of TFTP. To change the default boot method:
Choose the primary boot method to use, either TFTP, NFS, or MOP:
For TFTP, check Workbook line 28. Ignore boot host and path settings.
For NFS, check Workbook line 29. Ignore boot path setting.
For MOP, check Workbook line 30. Ignore boot path setting.
Check Workbook line 42 to save the new method.
Booting from a specified host, using parameters obtained from the network. Set
up automatic booting (from the previous section) on every boot host. Add the
information for the specific network computer to the specific boot host.
- You can change only the boot method. Follow the preceding check mark
paragraphs for the booting from the first available host section.
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File Access Strategies
File access determines how the network computer locates and downloads
configuration and font files. As discussed in the Configuration Strategies
section, you can have one or more file hosts.
The file access path you specify is actually the path to the configuration (.tbl)
files. For fonts, the fonts.tbl file contains the actual paths to the files, not the
actual fonts. This may be confusing at first, but makes sense if you think about
it. Font files take up a lot of disk space. By having the configuration file point
to the various locations, you can distribute fonts across disks, partitions, or
different hosts, depending on your disk space.
Here are some considerations for a file host:
• The host may be frequently accessed during a user session.
• Font files use a lot of disk space, so make sure you only have the ones you
need. Many of the fonts on the installation media are probably duplicates of
your host computer’s native fonts. If the X server can read your computer’s
native fonts, use them and only keep the unique fonts from the installation
media.
• Place the files on a machine with enough room. This does not have to be the
boot host; the files can be installed in any directory on any machine on the
network accessible to the network computers.
• The entries in the fonts.tbl file use network computer memory, so only add
the font directories your applications require.
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File Access Methods
The file access method choices are similar to the boot method choices. The file
access methods are: TFTP, NFS, DAP, and SXP. The method you select is
dependent on your network type and how your users connect.
NOTE: When a file_path is requested, provide the path to the .tbl
files. The default path is /tekxp/boot/config. In most cases, these
entries are not required.
If you do not enable any file access hosts or methods, the boot host and boot
method are used by the network computer.
NOTE: NT systems only support NFS file access.
• NFS can be used on hosts supporting NFS (typically on a TCP/IP network).
The advantage to NFS is downloading speed and efficiency.
• TFTP can be used on TCP/IP networks. It is not as efficient as NFS.
• DAP is used on DECnet networks to download files to the network computers.
• SXP is used to download files for a Serial Xpress connection.
Select a primary file access method:
Check Workbook line 10 to use NFS as the primary file access method.
Check Workbook line 11 to use TFTP as the primary file access method.
Check Workbook line 12 to use DAP as the primary file access method.
Check Workbook line 13 to use SXP as the primary file access method.
In addition, a secondary (backup) method can be enabled. The secondary
information is only used if the primary method fails.
Select a secondary file access method:
Check Workbook line 14 to use NFS as the secondary method.
Check Workbook line 15 to use TFTP as the secondary method.
Check Workbook line 16 to use DAP as the secondary method.
Check Workbook line 17 to use SXP as the secondary method.
NOTE: If the last method tried is NFS, the network computer
automatically tries TFTP using the last file path specified. To take
advantage of this feature, make sure TFTP is enabled.
Check Workbook line 56 to enable TFTP.
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Host Connection Strategies
Host connection specifies how a user connects to their login host. There are
several possibilities:
• TekHostMenu presents a list of hosts. The user uses the mouse to select a
session type and login host (this is the default method). This is easy to use
and provides flexibility for users who need access to multiple hosts.
• Login Window to a Specific Host. Displays a host login box where the user
simply logs in to the host.
• Session Window to a Specific Host. Opens a session window and connects
to the specific host. The user simply logs in.
• Session Window with no Specified Host. Opens a session window. The
user would have to specify a host connection and then log in.
• No connection method. The user would have to start a session from the
Client Launcher and then log in.
Pick the method that best fits your users and your environment.
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TekHostMenu
TekHostMenu is the default connection method. Within the TekHostMenu
interface, there are multiple lists of hosts available: XDMCP, VMS (both
TDEnet and TCP/IP connections), TELNET, CTERM, LAT, IBM and
WinDD. A user can pick the list to view, and then pick a host from that list. You
can support as many of the lists as apply to your environment.
• XDMCP - this is a generated list based on hosts that respond to the network
computer’s xdm broadcast. xdm must be enabled on the host. Responding
hosts can be optionally prioritized to appear at the top of the list.
Check Workbook line 61 to enable xdm on the host.
Check Workbook line 43 to optionally prioritize hosts on the list.
• VMS TDEnet - this is a list of entries you specify in the xp.cnf file. Use this
list if you connect to DEC hosts running DECnet.
Check Workbook line 44 to add VMS TDEnet host entries.
• VMS TCP/IP - this is a list of entries you specify in the xp.cnf file. Use this
list if your users connect to DEC hosts running TCP/IP.
Check Workbook line 45 to add VMS TCP/IP host entries.
• TELNET - this is a list of entries you specify in the xp.cnf file. In addition,
the boot host and the default Telnet host (if defined) appears on the list. Use
this list if your users connect to TCP/IP hosts via Telnet.
Check Workbook line 46 to add TELNET host entries.
Check Workbook line 38 to define a default TELNET host.
• CTERM - this is a list of entries you specify in the xp.cnf file. In addition,
the boot host and the default CTERM host (if defined) appears on the list.
Use this list if your users connect to DECnet hosts via CTERM.
Check Workbook line 47 to add CTERM host entries.
Check Workbook line 39 to define a default CTERM host.
• LAT - this is a generated list based on available LAT services.
Check Workbook line 9 to start LAT services on the host
• IBM - this is a list of IBM host entries you specify in the xp.cnf file.
Check Workbook line 47 to add IBM host entries.
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• WinDD - this is a list of WinDD servers you specify in the xp.cnf file.
Check Workbook line 49 to add WinDD server entries.

Login Window to a Specific Host
This option uses a utility on the specified host to display a login box on the
network computer. The method you select for this option is network and host
connection dependent.
If your user logs in to a TCP/IP host on a TCP/IP network:
Check Workbook line 18 to specify a direct host connection.
Check Workbook line 61 to enable xdm on the host.
If your user logs in to a DECnet node in a DEC environment:
Check Workbook line 19 to specify a direct host connection.
Check Workbook line 67 to enable DECwindows on the host.
If your user logs in to a TCP/IP host in a DEC environment:
Check Workbook line 20 to specify a direct host connection.
Check Workbook line 61 to enable xdm on the host.
If your user logs in to a Windows NT server:
Check Workbook line 20 to specify a direct WinDD host connection.
Check Workbook line 68 to install WinDD on the Windows NT server.
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Session Window to a Specific Host
This option can be used to display either a TELNET or CTERM session
window on a defined host or node. The session you select for this option is host
dependent.
If your user logs in to a TCP/IP host, specify the connect method to be
TELNET, and define the default Telnet host:
Check Workbook line 21 to specify TELNET.
Check Workbook line 38 to define a default Telnet host.
If your user logs in to a DECnet node, specify the connect method to be
CTERM, and define the default CTERM host:
Check Workbook line 22 to specify CTERM.
Check Workbook line 39 to define a default CTERM host.

Session Window with No Specific Host
This option opens a session window. The user would have to open a host
connection or service. Several sessions are available: TELNET, CTERM,
LAT, SERIAL0, and SERIAL1. The session type you select is network and
host connection dependent.
If your user logs in to a TCP/IP host:
Check Workbook line 21 to specify a Telnet session.
If your user logs in to a DECnet node:
Check Workbook line 22 to specify a CTERM session.
If your user logs in to a LAT service:
Check Workbook line 23 to specify a LAT session.
If your user logs in via a serial connection on their network computer serial
port 0:
Check Workbook line 24 to specify a Serial0 session.
If your user logs in via a serial connection on their network computer serial
port 1:
Check Workbook line 25 to specify a Serial1 session.
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No Connection Method
You can have the network computer simply display the root weave and X cursor
by disabling host connections. A user would have to start a session from the
Client Launcher.
To disable host connections:
Check Workbook line 27.
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ROM and Flash Memory Strategies
Reading Host-Based Remote Configuration Files
Network computers with Flash Memory can be set up to read an xp.cnf file on
the host. Another strategy if you have space in Flash Memory, is to flash a
version of xp.cnf, to free the network computer from trying to find a host during
the boot process.
Check Workbook line 35 to read a host-based xp.cnf file with a network
computer equipped with Flash Memory.
XP10 models equipped with the ROM (Read Only Memory) options can also
read an xp.cnf file.
Check Workbook line 31 to read an xp.cnf file with an XP10 ROM model.

Saving your Configuration in Flash Memory
As you have worked through this chapter, you have selected the commands to
implement in the configuration file. For RAM-based network computers, this
configuration can either be saved in NVRAM, or loaded each time the network
computer boots and reads the xp.cnf file. To take advantage of the Flash
Memory option, you can flash all or part of your configuration.
This section provides the basic flash procedure. Refer to Chapter 2 of the
Network Computer Reference manual for the specific flash commands.
• Create a remote configuration file with the do_flash and appropriate
flash_feature enabled. Change the boot_method to ROM (for subsequent
boots). If you are not going to flash the remote configuration file, you may
wish to set the network computer to read a host-based xp.cnf file.
• Boot only the network computers that you want to flash. Use TFTP, NFS,
or MOP as the boot method. You cannot flash a network computer that
booted from Flash Memory (boot method ROM).
• Once flashing is complete, comment out the flash information in the xp.cnf
file. Restore the boot_method settings as needed for your other network
computers.
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Enabling a Master Network Computer
A network computer equipped with Flash memory can be used as a master
network computer to boot other network computers.
Check Workbook line 36 to enable or boot from a master network computer.

Boot Host Check List
Use this check list to verify that each boot host is completely configured:
• Boot software installed
• ip_host_table and ip_host_entry commands added to the xp.cnf file
Check Workbook line 1.
• gateway_table and gateway_entry commands added to the xp.cnf file if the
network computers are located on different subnets and require a gateway
Check Workbook line 3.
• Primary and Secondary (if used) boot method enabled
• xp.cnf file configured
• Supporting host processes enabled and running
NOTE: The _table (ip_host_table) commands store up to four entries
in the network computer’s NVRAM. Use them for the most frequently
accessed hosts. The _entry (ip_host_entry) commands store all
subsequent entries into RAM.

File Host Check List
Use this check list to verify that each file host is completely configured:
• Configuration and font files installed
• ip_host_table and ip_host_entry commands added to the xp.cnf file
Check Workbook line 1.
• gateway_table and gateway_entry commands added to the xp.cnf file if the
network computers are located on different subnets and require a gateway
Check Workbook line 3.
• Primary and Secondary (if used) file access method enabled
• Font paths added to fonts.tbl file
Check Workbook line 55.
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Network Computer Check List
Gather the following information for each network computer:
• Network computer model (to determine boot path)
• Network computer hardware address
• Network computer name
• Network computer network address
This list shows the various host files that need network computer information:
• /etc/host or \winnt35\system32\drivers\etc\hosts is needed on all hosts the
network computer accesses.
Check Workbook line 62.
• bootptab file, if bootp is used, is needed on all boot hosts.
Check Workbook line 58.

What Next?
• Edit the xp.cnf file and implement any commands you checked on Workbook
page 2-19 through page 2-32. Or, if the majority of your check marked lines
have a corresponding Setup menu item, you may wish to enter your
information in Setup and use the Save Settings to File feature. Any remaining
check marked items could be added to the created file.
• Edit any of the .tbl files you checked on Workbook page 2-34.
When you are done editing the configuration files, continue on to the chapter
Supporting a Centralized System for your host type.
• Perform the host procedures you checked on Workbook page 2-35.
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Configuration Workbook
To
Do

__

Setup Menu
Paths

xp.cnf File
1. Enter one or more host address/names (NVRAM).

Network Tables
and Utilities

ip_host_table _______________

________________

ip_host_table _______________

________________

⇓

ip_host_table _______________

________________

Internet Host

ip_host_table _______________

________________

If you have additional hosts, fill out Workbook line 5.

…………………………

__

……

2. Enter one or more node address/names (NVRAM).

Network Tables
and Utilities

tde_host_table _______________

_______________

tde_host_table _______________

_______________

⇓

tde_host_table _______________

_______________

TDEnet Host

tde_host_table _______________

_______________

If you have additional nodes, fill out Workbook line 6.

…………………………

__

……

3. Enter one or more net address/gateway addresses (NVRAM).

Network Tables
and Utilities

gateway_table _______________

________________

gateway_table _______________

________________

⇓

gateway_table _______________

________________

Gateway

gateway_table _______________

________________

If you have additional hosts, fill out Workbook line 7.

__

…………………………

……

4. Enter one or more file system name/local directories (NVRAM)
along with the file transfer size (128 - 8192).

Network Tables
and Utilities

nfs_table ______________

_______________ _____

⇓

nfs_table ______________

_______________ _____

NFS Mount

nfs_table ______________

_______________ _____

nfs_table ______________

_______________ _____

Fill out Workbook line 57. Also, if you have additional NFS
entries, fill out Workbook line 8.

…………………………

……
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5. Enter one or more host address/names (RAM).
ip_host_entry _______________

________________

ip_host_entry _______________

________________

ip_host_entry _______________

________________

ip_host_entry _______________

________________

Not available

Continue adding entries as needed.

…………………………

__

6. Enter one or more node address/names (RAM).
tde_host_entry _______________

_______________

tde_host_entry _______________

_______________

tde_host_entry _______________

_______________

tde_host_entry _______________

_______________

……
Not available

Continue adding entries as needed.

…………………………

__

7. Enter one or more net address/gateway addresses (RAM).
gateway_entry _______________

________________

gateway_entry _______________

________________

gateway_entry _______________

________________

gateway_entry _______________

________________

……
Not available

Continue adding entries as needed.

…………………………

__

8. Enter one or more file system name/local directories (RAM)
along with the file transfer size (128 - 8192).
nfs_entry ______________

_______________ _____

nfs_entry ______________

_______________ _____

nfs_entry ______________

_______________ _____

nfs_entry ______________

_______________ _____

……
Not available

Continue adding entries as needed.
Fill out Workbook line 57.

…………………………
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9. Enter node name/LAT service tables (up to 20 services).

Not available

lat_services_table ____________ ______________
lat_services_table ____________ ______________
lat_services_table ____________ ______________

Continue adding services up to 20.

__

…………………………

……

10. Enter the file system name (for file_host_name) and the local
directory (for file_path).

Configuration
Summaries

file_access_1 NFS
file_host_name_1 _____________________________

⇓

Host File Access

file_path_1 __________________________________

Fill out Workbook line 4 and Workbook line 57.

…………………………

__

……

11. Enter the host address or name and the file path.

Configuration
Summaries

file_access_1 TFTP
file_host_name_1 _____________________________

⇓

file_path_1 __________________________________

Host File Access

Fill out Workbook line 56.

…………………………

__

……

12. Enter the node address or name and the file path.

Configuration
Summaries

file_access_1 DAP
file_host_name_1 ____________________________

⇓

file_path_1 _________________________________

Host File Access

Fill out Workbook line 64.

…………………………

__

13. No host name or file path is used.
file_access_1 SXP

Fill out Workbook line 63.

……
Configuration
Summaries

⇓

Host File Access

…………………………

……
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14. Enter the file system name (for file_host_name) and the local
directory (for file_path).
file_access_2 NFS
file_host_name_2 ____________________________

Setup Menu
Paths
Configuration
Summaries

⇓

Host File Access

file_path_2 _________________________________

Fill out Workbook line 4 and Workbook line 57.

…………………………

__

15. Enter the host address or name and the file path.
file_access_2 TFTP

……
Configuration
Summaries

file_host_name_2 ____________________________

⇓

file_path_2 _________________________________

Host File Access

Fill out Workbook line 56.

…………………………

__

16. Enter the node address or name and the file path.
file_access_2 DAP

……
Configuration
Summaries

file_host_name_2 ____________________________

⇓

file_path_2 _________________________________

Host File Access

Fill out Workbook line 64.

…………………………

__

17. No host name or file path is used.
file_access_1 SXP

Fill out Workbook line 63.

……
Configuration
Summaries

⇓

Host File Access

…………………………

__

18. Enter the address or name of the XDMCP host.
host_connect_method XDMCP
xdmcp_connect DIRECT
xdmcp_server ___________________________

……
Configuration
Summaries

⇓

X Environment

Fill out Workbook line 61.

…………………………

2-22

Windows NT Installation

……

Configuration Workbook

To
Do

__

Setup Menu
Paths

xp.cnf File
19. Enter the node address or name.

Configuration
Summaries

host_connect_method VMS

⇓

vms_autologin_transport TDENET
vms_autologin_tdenet_host _______________::

X Environment

Fill out Workbook line 67.

…………………………

__

……

20. Enter the host address or name.

Configuration
Summaries

host_connect_method VMS

⇓

vms_autologin_transport TCPIP
vms_autologin_tcpip_host ___________________

X Environment

Fill out Workbook line 61.

…………………………

__

21. host_connect_method TELNET
Fill out Workbook line 38.

……
Configuration
Summaries

⇓

X Environment

…………………………

__

22. host_connect_method CTERM
Fill out Workbook line 39.

……
Configuration
Summaries

⇓

X Environment

…………………………

__

23. host_connect_method LAT
Fill out Workbook line 9.

……
Configuration
Summaries

⇓

X Environment

…………………………

__

24. host_connect_method SERIAL0
Fill out Workbook line 40 and Workbook line 63.

……
Configuration
Summaries

⇓

X Environment

…………………………

……
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25. host_connect_method SERIAL1
Fill out Workbook line 41 and Workbook line 63.

Setup Menu
Paths
Configuration
Summaries

⇓

X Environment

…………………………

__

26. host_connect_method WINDD
Fill out Workbook line 49.

……
Configuration
Summaries

⇓

X Environment

…………………………

__

27. host_connect_method DISABLED

……
Configuration
Summaries

⇓

X Environment

…………………………

__

28. Enter the host address or name and path to the os file.
boot_method TFTP

……
Configuration
Summaries

boot_host_name ____________________________

⇓

boot_path _________________________________

Boot

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 56.

…………………………
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29. Enter the NFS read size and the path to the os file.
boot_method NFS ___________________________
boot_path _________________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

Configuration
Summaries

⇓

Boot

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 57.

…………………………

__

……
Configuration
Summaries

30. Enter the path to the OS file.
boot_method MOP
boot_path _________________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

⇓

Boot

boot_path _________XP10_OS

select FAMILY=XP100 boot_path _________XP350_OS
select FAMILY=XP330 boot_path _________XP330_OS
select FAMILY=XP350 boot_path _________XP350_OS
select FAMILY=NC200 boot_path _________NC200_OS
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 64.

…………………………

……
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31. If you have an XP10 series with a ROM card (not a Flash
Memory card) you can optionally read an xp.cnf file during
subsequent boots by specifying a host address or name and path
to the xp.cnf file.

Setup Menu
Paths
Configuration
Summaries

⇓

Boot

boot_method ROM
boot_host _________________________________
boot_path _________________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

…………………………

__

32. Enter the host address or name and path to the os file.
boot_method_2 TFTP

……
Configuration
Summaries

boot_host_name_2 __________________________

⇓

boot_path_2 _______________________________

Boot

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 56.

…………………………
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33. Enter the NFS read size and the path to the os file.
boot_method_2 NFS _________________________
boot_path_2 _______________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

Configuration
Summaries

⇓

Boot

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 57.

…………………………

__

……
Configuration
Summaries

34. Enter the path to the OS file.
boot_method_2 MOP
boot_path_2 _______________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

⇓

Boot

boot_path _________XP10_OS

select FAMILY=XP100 boot_path _________XP350_OS
select FAMILY=XP330 boot_path _________XP330_OS
select FAMILY=XP350 boot_path _________XP350_OS
select FAMILY=NC200 boot_path _________NC200_OS
select FAMILY=NC400 boot_path ___________os.500

Fill out Workbook line 64.

…………………………

……
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35. If you have a Flash Memory card you can optionally read an
xp.cnf file during subsequent boots by specifying a boot
method other than ROM (either MOP, TFTP or NFS) and a host
address or name and path to the xp.cnf file.

Setup Menu
Paths
Configuration
Summaries

⇓

Boot

boot_method_2 _____________________________
boot_host_2 _______________________________
boot_path_2 _______________________________

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP10

boot_path ___________os.10

select FAMILY=XP100 boot_path ___________os.350
select FAMILY=XP330 boot_path ___________os.330
select FAMILY=XP350 boot_path ___________os.350
select FAMILY=NC200 boot_path ___________os.500
select FAMILY=NC400 boot_path ___________os.500

…………………………

__

36. Set booting to be from a flash-equipped master network
computer. Use the name or address of the master network
computer.
boot_method TFTP

……
Configuration
Summaries

⇓

Boot

boot_host ____________________
boot_path /rom/os.<model>
select TERMINAL NAME=___ enable_tftp_daemon YES

…………………………

__

37. Set booting to be from values stored in NVRAM, instead of
values obtained from the network.
determine_address_from NVRAM

……
Configuration
Summaries

⇓

Boot

…………………………
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38. Enter the address or name of the default Telnet host.
default_telnet_host _________________________

Configuration
Summaries

⇓

TCP/IP

…………………………

__

……

39. Enter the address or name of the default CTERM node.
default_cterm_host _________________________

Configuration
Summaries

⇓

TDEnet

…………………………

__

40. Enter the parameters for Serial port 0.
data_bits_0 ___________
stop_bits_0 ___________
parity_0

_____________

……
Configuration
Summaries

⇓

Peripheral Ports

flow_control_0 ________
baud_rate_0

__________

…………………………

__

41. Enter the parameters for Serial port 1.
data_bits_1 ___________
stop_bits_1 ___________
parity_1

_____________

……
Configuration
Summaries

⇓

Peripheral Ports

flow_control_1 ________
baud_rate_1

__________

…………………………

__

42. save_current_settings

…………………………

……
Not available

……
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__

43. Add an address or name for the XDMCP hosts to appear at the
top of the TekHostMenu XDMCP list.

Setup Menu
Paths
Not available

xdmcp_menu_entry ____________________
xdmcp_menu_entry ____________________
xdmcp_menu_entry ____________________

Continue adding entries as needed.

__

…………………………

……

44. Add an address or name for all preferred nodes to appear at the
top of the TekHostMenu VMS TDEnet list.

Not available

vms_menu_entry TDEnet _______________ PREF
vms_menu_entry TDEnet _______________ PREF
vms_menu_entry TDEnet _______________ PREF

Add an address or name for all other nodes to appear on the
TekHostMenu VMS TDEnet list.
vms_menu_entry TDEnet ___________ NOTPREF
vms_menu_entry TDEnet ___________ NOTPREF
vms_menu_entry TDEnet ___________ NOTPREF

Continue adding entries as needed.

__

…………………………

……

45. Add an address or name for all preferred nodes to appear at the
top of the TekHostMenu VMS TCP/IP list.

Not available

vms_menu_entry TCPIP ________________ PREF
vms_menu_entry TCPIP ________________ PREF
vms_menu_entry TCPIP ________________ PREF

Add an address or name for all other nodes to appear on the
TekHostMenu VMS TCPIP list.
vms_menu_entry TCPIP ____________ NOTPREF
vms_menu_entry TCPIP ____________ NOTPREF
vms_menu_entry TCPIP ____________ NOTPREF

Continue adding entries as needed.

…………………………
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46. Add an address or name for all preferred hosts to appear at the
top of the TekHostMenu TELNET list. Specify the emulator to
use for the session (TEK220 or TEK340).
telnet_menu_entry ________________ PREF _______

Network Tables
and Utilities

⇓

Internet Host

telnet_menu_entry ________________ PREF _______
telnet_menu_entry ________________ PREF _______

Add an address or name for all other hosts to appear on the
TekHostMenu TELNET list. Specify the emulator to use for the
session (TEK220 or TEK340).
telnet_menu_entry ______________ NOTPREF ______
telnet_menu_entry ______________ NOTPREF ______
telnet_menu_entry ______________ NOTPREF ______

Continue adding entries as needed.

__

…………………………

……

47. Add an address or name for all preferred nodes to appear at the
top of the TekHostMenu CTERM list. Specify the emulator to
use for the session (TEK220 or TEK340).

Network Tables
and Utilities

cterm_menu_entry __________________ PREF ______

⇓

TDEnet Host

cterm_menu_entry __________________ PREF ______
cterm_menu_entry __________________ PREF ______

Add an address or name for all other nodes to appear on the
TekHostMenu CTERM list. Specify the emulator to use for the
session (TEK220 or TEK340).
cterm_menu_entry _______________ NOTPREF ______
cterm_menu_entry _______________ NOTPREF ______
cterm_menu_entry _______________ NOTPREF ______

Continue adding entries as needed.

…………………………

……
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48. Add an address or name for all preferred IBM hosts to appear at
the top of the TekHostMenu IBM list. Specify the emulator to
use for the session (TEK220 or TEK340), the model (2, 3, 4,
5), and the protocol (TN or OCS).

Setup Menu
Paths
Not available

ibm_menu_entry ____________ PREF ______ __ ____
ibm_menu_entry ____________ PREF ______ __ ____
ibm_menu_entry ____________ PREF ______ __ ____

Add an address or name for all other IBM hosts to appear on
the TekHostMenu IBM list.
cterm_menu_entry ________ NOTPREF _____ __ ____
cterm_menu_entry ________ NOTPREF _____ __ ____
cterm_menu_entry ________ NOTPREF _____ __ ____

Continue adding entries as needed.

__

…………………………

……

49. Add an address or name for all preferred WinDD servers to
appear at the top of the TekHostMenu WinDD list. Specify the
window size to use for the session (640, 800, 1024, 1280),
whether to reconnect after a session log off (NORECONNECT,
RECONNECT), and whether to display the menubar
(MENUBAR, NOMENUBAR).

Not available

windd_menu_entry ________ PREF __ _______ _____
windd_menu_entry ________ PREF __ _______ _____
windd_menu_entry ________ PREF __ _______ _____

Add an address or name for all other WinDD servers to appear
on the TekHostMenu WinDD list.
windd_menu_entry _______ NOTPREF __ ______ ____
windd_menu_entry _______ NOTPREF __ ______ ____
windd_menu_entry _______ NOTPREF __ ______ ____

Continue adding entries as needed.

…………………………
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50. Add the name or address and configuration information for the
WinDD server when the host_connect_method is set to
WINDD. windd_size can be 640, 800, 1024, 1280).
windd_auto_connect, windd_auto_reconnect, and
windd_entrybox can be set as ENABLED or DISABLED.
windd_menubar can be set as YES or NO.

Not available

windd_host_name _____________________
windd_size ___________________________
windd_auto_connect ___________________
windd_auto_reconnect _________________
windd_menubar ________________________
windd_entrybox _______________________

…………………………

……
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__

51. Edit the gateway.tbl file and enter as many additional gateways
as needed.

Network Tables
and Utilities

⇓

Gateway

…………………………

__

52. Edit the hosts.tbl file and enter as many additional hosts as
needed.

……
Network Tables
and Utilities

⇓

Internet Host

…………………………

__

53. Edit the file nodes.tbl and enter as many additional nodes as
needed.

……
Network Tables
and Utilities

⇓

TDEnet Host

__

…………………………

……

54. Edit the nfs.tbl file and enter as many additional NFS mounts as
needed.

Network Tables
and Utilities

⇓

NFS Mount

…………………………

__

55. Edit the fonts.tbl file and enter the directory paths (Example:
/tekxp/boot/fonts/misc).

……
Network Tables
and Utilities

______________________________________________

⇓

______________________________________________

Font Directory

______________________________________________
______________________________________________

…………………………
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56. Enable tftp on the host

…………………………

__

57. Enable NFS on the host

…………………………

__

58. Enable bootp on the host

…………………………

__

59. Enable DHCP on the host (see Chapter 5)

…………………………

__

60. Enable rarp on the host

…………………………

__

61. Enable XDM on the host

…………………………

__

62. Add network computer entries to /etc/host file

…………………………

__

63. Set up Serial Xpress (see the Serial Xpress User manual)

…………………………

__

64. Enable MOP on the host

…………………………

__

65. Add the nodes to the NCP database

…………………………

__

66. Create Proxy accounts on the host

…………………………

__

67. Enable DECwindows on the host

…………………………

__

68. Install WinDD on the Windows NT server.

…………………………

Windows NT Installation

2-35

Chapter 2

Making Choices

2-36

Windows NT Installation

Chapter

3

Supporting a Centralized System

colossus

ing
Good morn
.
Mr. Forbin....
guardian

/etc/hosts

This chapter contains procedures for setting up the necessary operating system
support files. Use the Workbook in Chapter 2 to determine the procedures
needed.
Your environment and the features you enable dictate the operating system
tasks. You must be root to modify the host files.
• NFS directories must be exported if NFS is used for booting or file access
• DHCP must be configured to be used for automatically determine
configuration information over the network
• Several Local Clients are available and can be started with xpsh or the Client
Launcher (See Chapter 4: Local Clients)
• Local Motif Window Manager (MWM) must be started to use local MWM
(See Chapter 5: Window Managers)
• OPENLOOK Window Manager (OLWM) must be started to use local
OLWM (See Chapter 5: Window Managers)
• ttys must be set for 8-bit mode in Tek220 sessions (Telnet, Cterm, or LAT)
• XIE must be enabled to run XIE applications (See Chapter 4: Local Clients)
• XPT/A graphics tablet must be configured on the host if it is used for input
(See Chapter 4: Local Clients)
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Enabling NFS
This section is an overview for enabling NFS on your NT host if NFS is used
as the boot_method or file_access_method. Refer to your NFS documentation
for specifics on installing and setting up NFS on your host.
1. Add the boot_directory (/tekxp/boot) to be exported on the host. Export as
read only. Refer to your NFS documentation for information on the name
and location of the exports file.
2. Edit the \winnt35\system32\drivers\etc\hosts file and add the network
computer name and address.
128.07.60.30

portland

3. To enable the mount point immediately, open the NFS ⇒ NFS Server dialog
box. Click on Exports. Use the Add button to add and verify mount points.
4. Open Main ⇒ Services to verify NFS is running.

Booting via NFS on a WinDD Server
To enable a WinDD server to be an NFS boot host.:
1. On the WinDD server, log in as the local administrator.
2. Open the Administrative Tools ⇒ User Manager for Domains window.
3. Create two new users, assigning each a password. For example, boot1 and
boot2.
4. Choose File ⇒ Run... and enter nfs.exe. In the NFS Server dialog box, click
on Users. The two new users appear in the Server Users dialog box.
5. Select the first user and enter the password in the User Password field. Enter
0 in the User ID field, and 1 in the Group ID field. Click on Modify.
6. Select the second user, and enter the password in the User Password field,
0 in the User ID field, and 0 in the Group ID field. Click on Modify.
You can now boot from the WinDD server.
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Configuring the Microsoft DHCP Server
NOTE: If the DHCP is not properly configured, multiple network
computers could be assigned the same IP address.
The Microsoft DHCP Server provides boot configuration information for NCD
network computers after you add two new NCBridge DHCP Options (or vendor
tags) to the DHCP server. If DHCP is not on your NT server:
• Install the Microsoft DHCP Server on the application server. For online
installation help, refer to: WindowsNT Help ⇒ Additional Networking
Services for Windows NT Server ⇒ TCP/IP ⇒ Installing and Configuring
DHCP Servers
• Reboot the system after installing DHCP. The DHCP Server is automatically
started.
The DHCP Manager administers the DHCP server. It is available through the
Network Administration program group. Initially, the Local Machine entry is
predefined and there are no scopes nor DHCP Options defined. When the first
scope is created, the DHCP Options are created in the Registry.

Creating the NCBridge Scope
The following steps must be performed for the scope of NCD network
computers to be managed and configured by the DHCP Server: Local
Machine.
1. Open the Network Administration group from the Program Manager
2. Open the DHCP Manager icon.
3. Create the scope of the NCBridge IP addresses. You must provide at least the
start and end range of addresses and the subnet mask. Online help for creating
scopes can be found in the DHCP Manager Help.
4. Select DHCP Options ⇒ Defaults

Windows NT Installation

3-3

Chapter 3

Supporting a Centralized System

5. Click on the New button. Add the following information to create the 066
(boot server address) vendor tag:
Name:
Boot Server address
Data Type: String
Identifier: 066
Comment: (This is an optional, user-defined field)
When complete, click OK to create the option.
6. To define the default value of the string, select the 066 Boot Server entry in
the Option Name entry box. The current value of the string should display as
an empty box. If you are using NFS to boot the network computer, select the
box and enter the IP address of the Boot Server, in this case, the IP address of
Local Machine.
7. Click on the New button. Add the following information to create the 067
(boot file) vendor tag:
Name:
Boot File
Data Type: String
Identifier: 067
Comment: (This is an optional, user-defined field)
When complete, click OK to create the option.
NOTE: For steps 5 and 7, the identifiers do not need to be created
when running Windows NT 4.0 Server and Terminal Server Edition.
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8. It may be appropriate to leave the default value of this option as a blank string
and define it either at the scope or client lease level. If there is only a single
os file to service any DHCP Server request, you can define it as the default
string value. To define the value of the string at the DHCP Option: Default
value, select the 067 Boot File entry in the Option Name entry box. The
current value of the string should display as an empty box. If you are using
NFS to boot the network computer, select the box and enter the NFS path of
the appropriate boot file directory for the network computer model, for
example, /tekxp/boot/
- To define the values of the DHCP Options at the Scope level, select a
scope from the DHCP Servers column, then select
DHCP Options ⇒ Scope
- To define the values of the DHCP Options at the Client Lease level,
select the Scope where the Client Lease entry can be found. Select
Scope ⇒ Active Leases. Select the Client Lease entry and then select the
Properties button. In the new Client Properties window, select the
Options button.
NOTE: If the option is not an Active Option, select it from the Unused
Options list and use the Add button to make it an Active Option.
Select the Option in the Active Options List and then click the Value
button. The current value shows up in the value box at the bottom
which you can then edit. Click OK to accept any changes.
9. For NFS booting of NCD network computers, it is suggested that the scopes
and/or leases defined to support the network computers contain following the
DHCP Options:
003
Router Gateway number
066
Boot server address/Primary boot host address
067
Boot file/Primary boot path
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Local Clients

This chapter describes various ways to start local client. Local clients are those
applications that execute on the network computer, rather than on the host, thus
reducing network traffic. TekHostMenu, Telnet, Cterm, and Setup are examples
of local clients. Local clients can be started with xpsh, the remote configuration
file (xp.cnf), with rsh, or with the Client Launcher.
This chapter also describes the Client Launcher, Audio Intercept Driver and
Server, Authorization Key Manager, XIE, XBlink, XPT/A Graphics Tablet,
Touchscreen Calibration, and the Common Desktop Environment.
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The following local clients are available on the network computer:
Analog Video Player
Audio Mixer
Audio Player
Authorization Key Manager
Cterm session
Common Desktop Environment (CDE)
Digital Video Player
LAT session
Local Client Launcher
Motif Window Manager (MWM)

Serial session
Setup
Telnet session
Touchscreen Calibration
WinDD
XBlink
XIE Viewer
Xlock client
XP Window Manager (XPWM)

NOTE: MWM, LAT, Cterm, XIE, the Tek340 emulator, the Digital
Video player, and CDE require an authorization key.

Determining Local Client Versions
To see the version of any local client in the boot directory, use the UNIX ident
command. For example, to see the version of Setup currently in use, enter ident
setup.350 (where 350 is the OS level you booted with). The version and level
information displays. You can use this command for any of the local clients.

Starting Local Clients With xpsh
xpsh is a host program used to download local clients to a network computer.
It is a two-way communication mechanism between the host program (xpsh)
and the local daemon (xpshd). xpsh sends information to the network computer
specifying which local clients to download, and xpsh receives local client error
messages and exit information from the network computer. xpsh can download
and start:
Starting a client using xpsh enables the client to run locally instead of from the
host. The host environment, client name, and arguments are sent to the local
network computer. For example, using xpsh to download MWM enables access
to files in $HOME. This allows you to customize the MWM environment for
an individual user.
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NOTE: When starting local clients with xpsh, instead of entering the
-display variable each time, you can set the environment variable
DISPLAY to nc_name:0. Then when starting local clients with xpsh,
enter xpsh and the local client only. For example:
xpsh tek220 -e cterm
xpsh tek340 -e telnet
xpsh mwm
xpsh tek220 -e llogin
xpsh tek220 -e tip tty0
xpsh tek340 -e tip tty1
xpsh xlock -mode 1
xpsh setup
To reduce the startup time for a local client started with xpsh, you can access
the client through an NFS path. (For information about NFS, refer to the
Supporting a Centralized System chapter for your host.) For example, if you
mount host_name:/tekxp/boot to /host_name/tekxp/boot on your network
computer, you can invoke MWM with the command:
xpsh /host_name/tekxp/boot/mwm
To start a local client using xpsh, enter the appropriate command below:

Starting the Analog Video Player
xpsh -display nc_name:0 xpvideo
The following options can be set on the xpsh command line:
-encode specifies the encoding format. Specify either NTSC (National
Television System Committee) or PAL (Phase Alternation
Line-rate).
-source specifies the video source to which the video device is connected.
Specify either COMPOSITE_1, COMPOSITE_2 or SVIDEO1.
-color specifies the color intensity of the video being played. Specify a
number from -1000 to 1000. 0 is the default.
-bright specifies the color brightness intensity of the video being played.
Specify a number from -1000 to 1000. 0 is the default.
-contrast specifies the color contrast intensity of the video being played.
Specify a number from -1000 to 1000. 0 is the default.
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-tint specifies the color tint of the video being played. Specify a number from
-1000 to 1000. 0 is the default.

Starting the Audio Mixer
xpsh -display nc_name:0 mixer

Starting the Audio Player
xpsh -display nc_name:0 aplay
The following options can be set on the xpsh command line:
-h

host — specifies the host name or address on which the audio file
resides. The host must be entered in the network computer’s Internet
Host Table in Setup. This host displays in the Audio Player’s File
Information area.

-f

filename and path — specifies the audio file name and its entire path.
This file displays in the Audio Player’s File Information area.

-a

access method — specifies the access method used to access the audio
file. Available access methods are tftp, nfs, and dap.

-v

volume level — specifies the volume level to use when playing the
audio file. Specify a number between 0 and 100, with 0 indicating no
volume, and 100 indicating the loudest volume setting.

-p

when used with the -h, -f, -a, and -v options, the specified file plays
without opening the Audio Player. The entire file plays and cannot be
interrupted.

Starting the Authorization Key Manager
xpsh authkey
The network computer reads the authkey.dat file when booting and updates
the network computer and authorization key information. (Be sure that
SNMP is available and enabled.)

Starting a Cterm session
A Cterm session can be started with a Tek220 or Tek340 emulator.
xpsh -display nc_name:0 tek220 -e cterm
xpsh -display nc_name:0 tek340 -e cterm
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Resource settings can be specified for a Cterm session. Refer to the next
section, Specifying Client Resource Settings.

Starting the Digital Video Player
xpsh -display nc_name:0 vplay
The following vplay options can be set on the xpsh command line:
-h

host — specifies the host name or address on which the video file
resides. The host must be entered in the network computer’s Internet
Host Table in Setup. This host displays in the Video Player’s File
Information area. When Multicasting, -h specifies the IP address. The
port number displays in the Video Player’s Addr/Port Information
area.

-f

filename and path — specifies the video file name and its entire path.
This file displays in the Video Player’s File Information area. When
Multicasting, -f specifies the port number. The address displays in the
Video Player’s Addr/Port Information area

-a

access method — specifies the access method used to access the video
file. Available access methods are tftp, nfs, dap, and Multicast. NFS
is the preferred file access method for faster and more accurate data
transfer rates required by the player. In addition, there is a 16MB limit
on files transferred with TFTP.

-v

volume level — specifies the volume level to use when playing the
video file. Specify a number between 0 and 100, with 0 indicating no
volume, and 100 indicating the loudest volume setting.

-m (Mute) specifies that the video file plays with no sound.
-c

(Color) specifies that the video file displays in color (used only if the
video was recorded in color).

-nc (No Color) specifies that the video file displays in greyscale images.
-brightness n — sets the brightness level of the video file. Specify a
number between -50 and +50.
-contrast n — sets the contrast level of the video file. Specify a number
between -50 and +50.
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-b

(Big) specifies that the video file displays in a frame four times the
size of the original file.

-p

(Playonly) when used with the options above, the specified file plays
without showing the Video Player. The entire file plays and cannot be
interrupted.

-all (Play All; software player only) plays all frames in a video file. Frame
scheduling is ignored and the audio will not be in sync.
-title "string" — assigns a title for the vplay windows.
-propcmd — creates properties that allow other clients to send command
strings to the Video Player. These properties cannot be changed or
modified and are used to control the Video Player from another client
that you create. For details about the properties, see the vplay man page.
-BUFSIZE n — (Hardware Player only) specifies the size of the Video
Player’s memory buffer (in kilobytes). The value defaults to 1024 and
can not be set lower than 1 kilobyte. If the value specified is greater than
available memory when trying to play a file, the Video Player reduces
its buffer to the available memory.
-CHKSIZE n — (Hardware Player only) specifies that the Video Player’s
memory buffer is divided into “chunks”, measured in kilobytes. The
network fills the chunks, and the Video Player empties them as they are
accessed. The default is 32, which divides the buffer into 32 kilobyte
chunks. If the chunk size is set to a number larger than the buffer size,
the chunk size will be truncated to one half the buffer size. The chunk
size cannot be set less than 1 kilobyte.
-CHKDELAY n — (Hardware Player only) specifies the time delay (in
milliseconds) that the Video Player waits following each read request
that fills a chunk.
-chan n — (Multicast only) specifies an index into an array of available
Multicast channels. Do not use with the -h, -f, -a, or -text options.
-text "string" — (Multicast only) specifies the channel string to be displayed
by the Video Player. Do not use with the -chan option.

Starting a LAT session
A LAT session can be started with a Tek220 or Tek340 emulator.
xpsh -display nc_name:0 tek220 -e llogin
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xpsh -display nc_name:0 tek340 -e llogin
Resource settings can be specified for a LAT session. Refer to the next
section, Specifying Client Resource Settings.

Starting the Local Client Launcher
xpsh -display nc_name:0 launcher
The following options can be added to the xpsh command line when starting
the Client Launcher:
-auto Configures the Client Launcher with the automatic default settings
even if a configuration file exists.
-file filename Configures the Client Launcher using a user-defined
configuration file.

Starting local MWM
xpsh -display nc_name:0 mwm
NOTE: If both MWM version 1.1 and MWM version 2.0 are
authorized, the 2.0 version will start.

Starting a Serial Session for Port 0 and Port 1
A serial session can be started with a Tek220 or Tek340 emulator for port 0
or port 1.
xpsh -display nc_name:0 tek220 -e tip tty0
xpsh -display nc_name:0 tek340 -e tip tty1

Starting Setup
xpsh -display nc_name:0 setup
A network computer’s Setup and Console window can also be started and
displayed on a remote network computer or host using xpsh. Once started,
you can use Setup to configure network computer settings, establish
communication connections, and monitor network computer operations.
To access a network computer’s Setup from a remote network computer or
host using C shell, enter:
setenv TEKSETUP_DISPLAY display_device:0
xpsh -display nc:0 setup
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If using a different type of shell tool, enter:
xpsh -display nc:0 -xpenv “TEKSETUP_DISPLAY \
= display_device:0” setup
where nc is the remote network computer whose Setup and Console window
is accessed, and display_device is the network computer or host where Setup
is to display. Use IP addresses if the remote network computer does not know
the host name of the display device (set up in the Internet Host Table in
Setup).
If the network computer user currently has Setup started, it is not accessible
remotely via xpsh. Likewise, if a remote network computer or host has Setup
open via xpsh, it is not available to the network computer user.
NOTE: To prevent other users from accessing your network
computer’s Setup and resetting the server, set enable_access_control
to Yes (in either the xp.cnf file or in Setup).

Starting a Telnet session
A Telnet session can be started with a Tek220 or Tek340 emulator.
xpsh -display nc_name:0 tek220 -e telnet
xpsh -display nc_name:0 tek340 -e telnet
Resource settings can be specified for a Telnet session. Refer to the next
section, Specifying Client Resource Settings.

Starting WinDD
xpsh can start the WinDD client as needed. To start WinDD with xpsh, enter
the following (where nc_name is the name or address of your network
computer):
xpsh -display nc_name:0 windd [options]
The following options can be set on the xpsh command line:
-display nc:0

Specifies the nc name or address to display the WinDD local client.
-c

Auto-connect to the first application server in the application server list.
If there are no application servers in the list, this option is ignored and
the client window is displayed.

-nc Do not auto-connect to an application server. (Default)
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-d

Displays the menu bar and the internal borders. (Default)

-nd Does not display the menu bar or the internal borders. For example, this
allows a 1280x1024 WinDD window to fully display on a 1280x1024
monitor (minus windows manager decorations).
-e

Enables the Application Server edit field window so that users can add
application servers to the application server list. (Default)

-ne Disables the Application Server edit field window so that users are not
allowed to add application servers to the application server list.
-floppy

Allows supported host versions of WinDD to use its local floppy drive
as a network connected drive for the Application Server. Only the first
host client to specify this option will be allowed to use the floppy
device. NOTE: For host clients (with local floppy drive) only.
-no_floppy_cache

Disables use of local floppy write cache. This is a fail-safe option to
ensure the entire file has been updated in the event a user suddenly
ejects a disk mechanically (when disks are ejected via the GUI button,
that process flushes the cache so no information is lost).
-geometry <geometry>
Standard X11 geometry option, <WidthxHeight+X+Y>.
-h <application server>
Adds the named application server(s) to the application server list.
Multiple application servers can be added to the list by listing them
separated by spaces.
-help

Displays a brief help list on the available WinDD command line
options.
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-initprog <prog> [-initdir <dir>]

Specifies the application to execute upon application server login. The
login session is terminated when the application is terminated.
Prog specifies the application and can also specify its path (up to 259
characters) and parameters. The program path and name are written
consecutively (and not separated by a space) when they are both
specified in prog. A space separates the program name and its
parameters. These parameters are program specific and can specify
program settings or data files to invoke on execution. Dir specifies the
path of the executable program.
-keysym_only

Specifies that all NCD network computer keyboards are supported with
keysym translations within WinDD.
-local_numlock

Specifies that WinDD manages the state of the Num_Lock independent
of any Xserver support.
-no_auto_numlock

Specifies that WinDD does not control the Num_Lock setting.
-login <username> [pass <passwd>] [-domain <domainname>]

Specifies the application server user account login name, login
password, and domain. These values will be used for user account
verification.
When using a WinDD client and connecting to a WinDD application
server, your username, password, domain, initial program, and initial
directory are encrypted as they are sent across the network.
Username, password, domainname, dir, and prog are not viewable or
changeable from the WinDD configuration window.
-r

Reconnect to the application server after log off.

-nr Does not reconnect to the application server after log off. (Default)
-version

Displays the WinDD version in use. (If the license is 8019, this option
also prints For evaluation purposes only.)
-x
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-nx Does not exit the WinDD client upon logging out of, or disconnecting

from, the application server. (Default)
-force_xcursor
Specifies that monochrome pointers within the WinDD desktop are to
be implemented using X cursors. Some monochrome pointers are xor’d
with the underlying desktop. When this switch is specified, it is no
longer xor’d, as X cursors do not support that mode.
NOTE: The force_xcursor feature is intended to compensate for
workstations that do not have a particularly high performance X
server. Consider using this option if the pointer flashes when move,
or poor performance is observed entering text in dialog boxes. Using
this switch improves user interactivity. The only side effect is the
pointer is displayed in a single color.

Starting the XIE Viewer
xpsh -display nc_name:0 xieview
The following options can be set on the xpsh command line:
-ifg color

specifies the color used as the foreground on bitonal images.
The color specified must be in the network computer’s rgb.txt
file.

-ibg color

specifies the color used as the background on bitonal images.
The color specified must be in the network computer’s rgb.txt
file.

-cc color

specifies the background color for the image window. The color
specified must be in the network computer’s rgb.txt file.

-fullpan True or False
If True, the image uses less memory when zoomed. If False, the
image uses more memory when zoomed. When set to False,
panning the image is faster. If there is not enough memory to
view the entire zoomed image, only part of the image will be
available when panning. The default is True.
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Starting Xlock
xpsh -display nc_name:0 xlock -mode <mode>
where <mode> is an optional setting. If set to 1, Xlock locks the keyboard
only. If set to 0, Xlock locks the keyboard and the screen. If a mode setting
is not given, Xlock locks the keyboard and the screen by default.
A password is required to use the Xlock client. The same password is used
throughout the entire session. If while using Xlock you forget the password,
you must reboot the network computer or reset the server (in Setup) to clear
the password and unlock the keyboard and screen.

Starting local XP Window Manager
xpsh -display nc_name:0 xpwm

Starting Local Clients In The xp.cnf File
Using the start and/or preload commands in the remote configuration file
(xp.cnf), you can determine which local clients are downloaded and/or started
at boot time. The specified clients are loaded into the network computer’s
memory and remain there until started. Even after closing the client, it remains
in RAM so that it can be restarted again. For information about starting local
clients from the remote configuration file, refer to the start and preload
commands in Chapter 2, Remote Configuration in the Network Computer
Reference Manual.

Starting Local Clients with rsh
rsh is a host program used to download local clients to a network computer. rsh
sends information to the network computer specifying which local clients to
download, however, unlike xpsh, rsh does not receive local client error
messages and exit information from the network computer.
Security for rsh is set through the .rhosts file. If user security is not set in
the .rhosts file, then users will be able to access all local clients. The
rshd_security command in the remote configuration file (xp.cnf) is used to
determine whether users can override the security features set by the system
administrator.

4-12

Windows NT Installation

Enabling rsh

Enabling rsh
Before starting local clients with rsh, you must first enable it. To do this, use the
start command with the parameter RSDH in the remote configuration file
(xp.cnf):
start

RSHD

Yes

Editing the .rhosts File
The .rhosts file is used to authenticate user requests to execute local clients.
Entries are either positive or negative, depending on the permissions you want
to give users. Positive entries enable user to access the specified local clients;
negative entries deny access. The entries should include the hostname,
username and client name. The order of entries within the files is important. If
the file contains both positive and negative entries, the entry that appears first
takes precedence.

Examples
For example, the entry below allows user judyl access to the Setup and Client
Launcher clients while logged into the host Sierra:
sierra

judyl

+setup

+launcher

If you do not list specific clients, then all clients are available to the specified
user:
sierra

judyl

A negative entry means that the client is not available to the user, but all other
clients are. For example, user judyl cannot access the Digital Video Player or
the Audio Player, but can access any of the other available clients:
sierra

judyl

-vplay

-aplay

You can also use the positive and negative specification for hostname and
usernames. In the following example, user paulb can access all clients from any
remote host:
+

paulb

In the next example, any user from any host can access the Setup and Launcher
clients:
+

+

+setup

+launcher
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In the final example, user davidb is not allowed access to the Setup and Xlock
clients from any host:
+

-davidb

+setup

+xlock

For details about the .rhosts file, refer to the rhosts man page for your host.

Starting Local Clients with rsh
rsh uses the same local client options as xpsh. When using rsh to start clients,
you do not enter the -display environment variable, and you must use the
network computer name instead of an address. For example, to start Setup with
rsh:
rsh nc_name setup
For details about starting local clients using rsh, refer to the Starting Local
Clients with xpsh section earlier in this chapter and substitute rsh for xpsh and
omit the -display environment variable and the :0 in all examples.
NOTE: rsh can start all the local clients that xpsh can start, except
for the Remote Setup client.
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Client Launcher
The local Client Launcher allows users to start local clients by simply selecting a
client from a menu using the mouse. Figure 4-1 shows a sample Client Launcher
menu. The Client Launcher can be configured automatically using default options,
or with a customized configuration file. It can be downloaded to the network
computer using the remote configuration file (xp.cnf) or using xpsh.

Figure 4-1 Client Launcher Menu.

Configuring the Client Launcher
There are two ways to configure the Client Launcher: default automatic
configuration, or with a specific configuration file. When the Client Launcher is
started, if a user-defined configuration file is not specified, it first searches for a
system.launcher configuration file. (A sample system.launcher file is located in /
tekxp/boot/config.) If that file is not found, it configures automatically.

Automatic Configuration
If there is no configuration file present, the Client Launcher automatically
configures and includes the following clients by default: Telnet, TekHostMenu,
Lock Screen, Console, and Setup. Serial Port 0 and/or 1 are included if the
network computer has serial ports. If Motif Window Manager, OPENLOOK
Window Manager, TDEnet, LAT, or Tek340 are authorized, they are included
as well. The Audio and Video players are included if authorized and if the
required hardware is present.
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The configuration files are accessed when the Client Launcher starts, and are
used to determine which clients are available to users. There are two different
types of configuration files:
• The system.launcher file configures multiple network computers so that the
clients available on the Client Launcher are the same for all who use the file.
This allows a system administrator to control which clients are available to
users.
• A user-defined configuration file customizes the Client Launcher for a user.
To create a configuration file:
1. Create a new file, naming it either system.launcher for a system-wide
configuration file, or whatever you like for a user-defined file, for example,
launch. A sample system.launcher file is located in /tekxp/boot/config.
2. Move the new file to the same directory where the xp.cnf file is located. (The
default location is /tekxp/boot/config.)
3. In the file, use a text editor to enter the main Client Launcher menu name in
uppercase letters.
4. On subsequent lines, enter each of the clients and sub-menu names (if used)
in double quotation marks to include on the Client Launcher followed by the
f.exec or f.menu option:
f.menu

specifies that a sub-menu is available with additional options. For
example, if you have both Motif Window Manager and
OPENLOOK Window Manager authorized, you could have a
Window Managers entry on the Client Launcher menu that opens a
second menu containing MWM and OLWM. You can use any
name or description you like with the f.menu option, however it
must end with the letters menu.

f.exec

specifies a local client to start immediately upon selecting it. Enter
the client name exactly as you would on the xpsh command line,
usually with all lower case letters and with double quotation marks.
For example, “telnet”, “console”, “setup”, and “mwm”.

The order in which you enter clients and sub-menus in the configuration file
determines the order they appear on the Client Launcher.
5. On the last line of the main menu, enter ENDMENU in uppercase letters.
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6. Create the submenus, if used, by entering the submenu name in all uppercase
letters. On subsequent lines, list the clients to include followed by f.exec
option in the same manner described in Step 4.
7. On the last line of each sub-menu, enter ENDMENU in uppercase letters.
In the following example, the Client Launcher menu contains the following
entries: Sessions (displays a submenu of available session clients), Multimedia
(displays a submenu), Console, TekHostMenu, Window Managers (displays a
submenu), and Setup.
Example 4-1 Sample Client Launcher Configuration File.

# Configuration file for Client Launcher
#
MAINMENU
"Sessions"
f.menu SESSIONS
"Multimedia"
f.menu MULTIMEDIA
"Console"
f.exec "console"
f.exec "TekHostMenu"
"TekHostMenu"
f.menu WINDOWS
"Window Managers"
"Setup"
f.exec "setup"
f.exec "quit"
"Exit"
ENDMENU
SESSIONS
"Serial 0"
"Telnet 220"
"Telnet 340"
ENDMENU

f.exec "tip -e tip tty0"
f.exec "xterm -e telnet"
f.exec "tek340 -e telnet"

MULTIMEDIA
"Audio Player"
"Digital Video"
"XIE Viewer"
"Audio Mixer"
ENDMENU

f.exec
f.exec
f.exec
f.exec

WINDOWS
"MWM"
"OLWM"
"XPWM"
ENDMENU

f.exec "mwm"
f.exec "olwm"
f.exec "xpwm"

"aplay -v 50"
"vplay -v 50"
"xieview"
"mixer"
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In the previous example, the f.exec option immediately starts a client or session,
and the f.menu option specifies that a submenu is to appear. The word
ENDMENU specifies the end of the menu options.
The main Client Launcher menu contains the MAINMENU entries of the
configuration file. When Sessions or Window Managers is selected, the
appropriate submenu displays.

Downloading the Client Launcher
The Client Launcher can be downloaded using the remote configuration file
(xp.cnf) or with xpsh.

Downloading Using the xp.cnf File
The start command in the xp.cnf file can be set to automatically download and
start the Client Launcher when the network computer boots. For information
about the start command and available parameters, refer to Chapter 2, Remote
Configuration in the Network Computer Reference Manual.
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Downloading With xpsh
When downloading and starting the Client Launcher using xpsh, the following
options can be set:
• -auto Configures the Client Launcher with the automatic default settings
even if a configuration file exists
• -file filename Configures the Client Launcher using a user-defined
configuration file
• -geometry x, y Configures the position of the Client Launcher. A positive
entry (+x, +y) orients from the upper left corner of the display. A negative
entry (-x, -y) orients from the lower right corner of the display.

Examples
The following example downloads and starts the Client Launcher with
automatic configuration on the network computer sierra:
xpsh

-display

sierra:0

launcher -auto

The following example downloads and starts the Client Launcher with
automatic configuration on the network computer sierra and positions it 30
pixels from the lower right corner:
xpsh

-display

sierra:0

launcher -auto -geometry -30-30

The following example downloads and starts the Client Launcher, configuring
its contents using a user-defined file named launch on the network computer
sierra:
xpsh -display
launch

sierra:0

launcher

-file\ /u1/user3/

The following example downloads and starts the Client Launcher, configuring
its contents using the system.launcher file on the network computer rocky:
xpsh -display rocky:0

launcher

The following example starts the Client Launcher with the automatic
configuration using the start command in the xp.cnf file:
start

launcher

-auto
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Using the Client Launcher
Once the Client Launcher is downloaded, press the Setup key to display the
Client Launcher main menu.
NOTE: To start the Client Launcher on a UNIX keyboard, press and
hold the AltGraph key (three keys to the right of the space bar) and
press the Help/Setup key (at the bottom left of the keyboard).
When the Client Launcher is started, it searches for configuration information
in the following order:
• In a user-defined configuration file, if specified
• The system.launcher configuration file
• If neither configuration file is found, the Client Launcher automatically
configures by listing all default and authorized clients
To open a client listed on the Client Launcher, simply position the mouse
pointer on the client name and click the mouse button once. To open a
sub-menu, position the mouse pointer on the menu name. The sub-menu
displays to the right of the Client Launcher main menu (refer to Figure 4-2).
Position the mouse pointer an item in the sub-menu and click the mouse button
once.
If the Client Launcher is iconified, pressing the Setup key displays it again (or
the AltGraph and Help/Setup keys on a UNIX keyboard). This is especially
useful if the Client Launcher icon is hidden under other open files.
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Authorization Key Manager
The Authorization Key Manager enables a system administrator to easily
update the authorization keys of several network computers. Authorization
keys are used to authorize special options used on the network computer, such
as window managers, XIE, TDEnet, and the video player.
Instead of entering each network computer’s authorization key one at a time,
you can update and maintain them from a central file. The Manager reads the
authkey.dat file, which contains the authorization keys for those network
computers you want to update with new options. When the file is read, those
network computers listed in the authkey.dat file are updated with a new key.

How the Authorization Key Manager Works
The Authorization Key Manager uses SNMP to query specific broadcast
addresses and network computers listed in the authkey.dat file, or in the
Authorization Key Manager client. Those network computers are then assigned
a new authorization key, also listed in the authkey.dat file. Therefore, you must
have and enable SNMP.

Setting Up SNMP
In the xp.cnf file, use the snmp_comm_list command to set the community list
to public and to allow read and write permissions:
snmp_comm_list

“host”

public

RW

where “host” is the host that performs the GET and SET operations when
querying the subnet, public is the community string, and RW indicates read and
write permissions.
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The authkey.dat File
The authkey.dat file is located in /tekxp/boot/config by default and is empty.
Edit the file to contain the broadcast address to query, the network computers
to update, and the new authorization keys. The following parameters are used
in the authkey.dat file:
broadcast

specify the broadcast address to query using SNMP.

terminal

for each network computer you want to update with a new
authorization key, enter its hardware address.

authorization key

For each network computer, enter the authorization key.
Each network computer must have a unique authorization
key.

The example below shows a sample authkey.dat file:
broadcast
terminal
terminal
terminal
terminal

144.67.33.255
08:00:34:94:33:EJ
08:46:22:69:47:32
08:42:90:00:31:69
08:47:35:69:21:21

JAB(4%>3+[=T;fjqc
AK)&AMB@.?JTOR&]\
Jk%3+=]klw\jvv<?!
Uu$^qvuIi#=/>1GLq

Starting the Authorization Key Manager
You can update authorization keys automatically with the xp.cnf file (and the
authkey.dat file), or you can open the Authorization Key Manager client. The
client provides a user interface where you can enter and delete authorization
key and network computer information before updating the authorization keys.

Updating the Authorization Key When Booting
To automatically update authorization keys when booting, edit the xp.cnf file to
uncomment the update_authkey command. The network computer reads the
authkey.dat file when booting and updates the network computer and
authorization key information. (Be sure that SNMP is available and enabled.)

Starting the Authorization Key Manager Client With xpsh
Use xpsh to open the Authorization Key Manager client as shown in Figure 1.
The client’s interface allows you to add and delete information from the
authkey.dat file, and to force the authkey.dat file to be read without having to
reboot the network computer.
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To start the client with xpsh, enter the following:
xpsh authkey

Using the Authorization Key Manager Client
The Authorization Key Manager client can be started only with xpsh. When it
starts, the window shown in Figure 4-2 appears.

Authorization Key Manager
NComputer List
Ethernet

Authorization Key

08:00:34:94:33:EJ

JAB(4%>3+[=T;fjqc

None

08:46:22:69:47:32

AK)&AMB@.?JTOR&]\

None

08:42:90:00:31:69

Jk%3+=]klw\jvv<?!

None

08:47:35:69:21:21

Uu$^qvuIi#=/>1GLq

None

Ethernet Address

IP Address

Authorization Key
Add Entry

Update
Authkey

Status

Edit
Broadcast List

Save
Authkey File

Delete Entry
Exit

Figure 4-2 Authorization Key Manager Window.
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The Authorization Key Manager window shows the ethernet addresses and
authorization keys as listed in the authkey.dat file. Before updating
authorization keys, you can add and delete information in this window. This
information is read in addition to the entries in the authkey.dat file. The
following topics are discussed:
• Adding and Deleting Network Computer Information
• Editing the Broadcast List
• Updating Authorization Keys
• Saving the authkey.dat File

Adding and Deleting Network Computer Information
The Authorization Key Manager window contains network computer
information necessary for updating authorization keys. If you have information
in the authkey.dat file, it displays in this window.
• To delete an entry, select the information to delete with the mouse and it
prefills in the Ethernet Address and Authorization Key fields. Then select
Delete Entry
• To add an entry, enter its ethernet address in the Ethernet Address field, and
its new authorization key in the Authorization Key field and select Add
Entry.
To apply your changes to the authkey.dat file, refer to Saving the Authkey File.

Editing the Broadcast List
The Authorization Key Manager searches the specified broadcast address for
those network computers that match the ethernet addresses listed in the
authkey.dat file. To view and or edit the broadcast list, select the Edit
Broadcast List button. The window shown in Figure 4-3 appears.
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Authorization Key Manager

Broadcast List
144.67.33.255

Broadcast Address

Add Entry

Return to
Main Menu

Delete Entry

Figure 4-3 Edit Broadcast List Window.

This window lists the broadcast addresses that the Authorization Key Manager
client searches when updating authorization keys. You can add and delete
information in this window. Information in this window is read in addition to
the entries in the authkey.dat file.
• To add a broadcast address, enter the address in the Broadcast Address field
and select Add Entry.
• To delete an address, select the address to delete with the mouse, and then
select Delete Entry.
To apply your changes to the authkey.dat file, refer to Saving the Authkey File.
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Updating Authorization Keys
When the correct information is in the Authorization Key Manager window,
select the Update Authkey button. The authorization keys are updated for
those network computers listed.
The update status for each network computer is displayed as either Successful
or Unreachable. If the status is Unreachable, check that you entered the correct
ethernet and authorization key information. Make sure also that you have
SNMP enabled.

Saving the Authkey File
After making changes to the ethernet addresses, authorization key, or broadcast
information, you can save those changes to the authkey.dat file. To save
changes, select Save Authkey File. The window shown in Figure 4-5 appears.
Authorization Key Manager
Save Authorization Key File
Access Method

TFTP

NFS

Host
File Name

Save
Authkey File

Figure 4-4 Save Authkey File Window.
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Return to
Main Menu

Using the Authorization Key Manager Client

1. Select the access method for saving the information to the file: NFS or TFTP.
NOTE: If you use TFTP as the access method, the file authkey.dat
must already exist and have world write permissions.
2. Enter the host name on which the authkey.dat file is located.
3. Enter the path and file name to which the information is to be saved.
4. Select the Save Authkey File button to save the information in the
Authorization Key Manager client to the authkey.dat file.
5. Select Return to Main Menu to exit the Save Authkey File window.
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Setting up XIE
X Imaging Extension (XIE) is a standard extension to the X11 Window System.
XIE is a library of support routines to add image enhancements and display
operations to applications. XIE programmer documentation is available from
MIT.
The XIE server is a network computer option. If the XIE option is available and
enabled, the XIE server is downloaded and attached to the network computer’s
X server. The XIE server requires approximately 400K of memory. XIE must
be authorized for the network computer, and then enabled through Setup or the
remote configuration file.

XIE Authorization
Use Setup to verify if XIE is authorized. There are two ways to verify XIE:
• Drag on Configuration Summaries and release on X Environment. If the
Enable XIE option appears on the screen, XIE is authorized.
• Drag on Statistics and release on Options. If XIE is listed, it is authorized.
If XIE was factory-loaded, the authorization key is already entered and XIE
should be available. If XIE was purchased separately, the authorization key
must be entered at the network computer Boot Monitor with the Authorize
command. See Chapter 4 Boot Monitor of the Network Computer Reference
manual.

Enabling XIE
XIE can be enabled through Setup or in the remote configuration file. In Setup,
drag on Configuration Summaries and release on X Environment. The Enable
XIE option should be Yes. In the xp.cnf file, use enable_xie.
To automatically download XIE each time the network computer is booted,
enable XIE and then use Save Current Settings. To download XIE on demand,
enter Setup and enable it, but do not select Save Current Settings. As soon as
it is enabled, XIE is downloaded.
To unload XIE from the server, enter Setup and disable it (use Save Current
Settings if you previously saved XIE as enabled), then reboot the network
computer.
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Setting up XBlink
XBlink provides the ability to cause graphics primitives to blink using a set of
dynamically loadable X extension functions. By modifying applications to call
these functions, a graphic element, such as text or a line, can alternate colors to
create a blinking affect. For example, to create the blink affect, a function could
be called passing in blue/yellow and 500/500 milliseconds, and return index 5.
If text is drawn with color index 5, then every 500 milliseconds the text would
alternate between the colors blue and yellow.
The XBlink Extension is applicable only for PseudoColor, DirectColor and
GrayScale visuals.

XBlink Authorization
XBlink must be authorized for use on a network computer. To use Setup to
verify if XBlink is authorized, drag on Statistics and release on Options. If
XBlink is listed, it is authorized.
If XBlink was factory-loaded, the authorization key is already entered and
XBlink should be available. If XBlink was purchased separately, the
authorization key must be entered at the network computer Boot Monitor with
the Authorize command. See Chapter 4 Boot Monitor of the Network
Computer Reference manual.

Enabling XBlink
XBlink is enabled in the remote configuration file with the enable_xblink
command. Uncomment the command in the xp.cnf file, set the parameter to
YES, and reboot the network computer.
enable_xblink

YES

To unload XBlink from the server, comment out the enable_xblink command,
or set its parameter to NO. Reboot the network computer.

Using XBlink
For details about the XBlink feature and its functions, refer to the xblink man
page, documented in Appendix C of the Network Computer Reference manual.
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Setting Up the XPT/A Graphics Tablet
The XPT/A graphics tablet provides a way to input graphics into your network
computer applications. Using the graphics tablet with an appropriate network
computer application, you can digitize and insert images, control cursor
movements, and make menu selections.
NOTE: The network computer must have a serial port in order to
connect the XPT/A Graphics Tablet
1. Install the graphics tablet using the procedure in the XPT/A Graphics Tablet
manual.
2. Specify the device description file for each port that a device will be
connected using either the remote configuration file or Setup:
- In the remote configuration file, use the input_ext_config_file_0 or
input_ext_config_file_1 command to specify the device description file.
Refer to Chapter 2, Remote Configuration in the Network Computer
Reference manual.
- In Setup, drag on Configuration Summaries and release on Input
Extension. Select the device connected to the appropriate port using the
Device on Serial Port 0 or Device on Serial Port 1 option, and then select
the core pointer using the Select Core Pointer Device option.
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Touchscreen Calibration Client
The Trident Touchscreen Calibration Client enables you to calibrate the
touchscreen. The Calibration Client is shown in Figure 4-5.

Calibrate
Up Threshold: 4

Down Threshold: 1

Jitter Control: 4

OutOfBounds Data: 0

Normal Mode

Figure 4-5 Calibration Client.

To invoke the Calibration Client, first map it to a keysym using the
keysym_action_entry command. For example, to invoke the client with the F1
key, enter the following in the xp.cnf file:
keysym_action_entry F1

TOUCH_CALIBRATE

ALL

Touchscreen jitter can be controlled with the touchSc_Jitter command:
touchSc_Jitter

4

# touch screen jitter control

In this example, the 4 indicates that a change of less than 5 pixels when touching
the screen will not move the cursor.
The Calibration Client includes the following elements:
NOTE: Not all elements are available on all touchscreen devices.
Only those elements needed for your touchscreen appear.
Up Threshold — controls the touch up threshold
Down Threshold — controls the touch down threshold
Jitter Control — controls the jitter and SAW touchscreen pressure threshold
OutOfBounds Data — controls the out of bounds data
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Normal Mode — controls the different touch modes. The available modes
are:
- Normal Mode: user touching the screen generates a button press; user
dragging his finger generates a button press motion (like pressing the
mouse button and dragging the mouse), user lifting his finger generates a
button release event.
- Point Mode: user touching the screen generates a button press and release
event immediately.
- Tap Mode: allows the touchscreen to operate like a mouse. The user
touching the screen generates a motion event allowing the user to drag the
cursor around the screen (like moving the mouse). Lifting his finger from
the screen and touching the screen again within a predefined time limit
(about 1/4 second) causes a button press event (like pressing a mouse
button). The user can now move his finger around the screen causing
button press motion events (like pressing the mouse button and moving
the mouse simultaneously). Removing his finger from the screen
generates a button release event (like releasing the mouse button).
- Release Mode: creates motion events as the user touches the screen and
drags his finger. When the user removes his finger, a button press event is
generated, followed immediately by a button release event.
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Common Desktop Environment
The Common Desktop Environment (CDE) is a collection of software
standards which defines an integrated, standard, and consistent graphical user
interface desktop environment.
CDE enables the network computer user to interact with a common
environment even though the network computer may be connected to a
heterogeneous network. It gives the user a common way of accessing resources
(printers, viewers, applications, etc.) that is independent of any particular host
on the network. In addition, CDE allows some services, such as the window
manager, to be run locally, thus reducing the load on the host.
The window manager component of TriTeal’s CDE implementation, called
TED, has been ported to NCD network computers. TED consists of two parts:
one running on the host, the other, known as local TED/CDE, running on the
network computer.

Requirements
The following requirements are needed to use local TED/CDE:
• You must have an appropriately licensed version of TED 4.0 running on your
host. Contact TriTeal to acquire a copy of TED which supports local TED.
• TED requires the network computer to have at least 12 MB of RAM,
although your usage of TED may require more memory
• The /usr/dt/config/xfonts/C directory must be accessible to the network
computer. This directory contains a fonts.alias file used by CDE.
• A network computer authorization key is required to use local CDE
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Starting the Local TED/CDE Client
To load the local dtwm window manager from dtlogin, each user must perform
the following steps:
NOTE: Be sure that tftp is enabled on the server if you will be using
it to load the fonts.
1. Change directories to the /examples directory.
cd <install_dir>/tekxp/examples
2. Execute the setup script for local TED:
# setup4localted

The setup script prompts you for the name of your host, the name of the
network computer, the path to dtpeer, and the path to xpsh. For all but the
network computer name, the script attempts to provide defaults. You can
override these defaults.
The script creates the following directory:
$HOME/.dt/bin/<host_name>/<nc_name>
In this directory, the script creates a link to dtpeer called dtwm, and a link to
xpsh called xpsh.
3. Logout and log back in.
When dtsession is run, the session manager loads the local dtwm and
connects with the peer. If this fails, the default host dtwm is run.
4. Make sure the network computer’s name is fully qualified on the host
machine in the file /etc/hosts. The entry should be this format:
<IP Address> <nc_name> <nc_name>.<domain_name>
For example,
134.62.10.199
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twinkle.tek.com

Starting the Local TED/CDE Client
Troubleshooting
If you experience problems, do the following:
• To determine if local TED is locating the host, look for the following
message in the Console:
Peer has been initialized and we can start dtwm.
Numerous "Cannot open file:" messages appear in the Console window.
Disregard these messages.
If local TED cannot locate the host, the following message appears:
No host entry for <hostname>
No socket.
• The dt peer waits for up to several minutes for the local dtwm to start. To
confirm that you are using the local dtwm, check the Workspace Menu to
see which dtwm was loaded. (Click on the right mouse button anywhere on
the background to bring up the menu.) The Restart Workspace Manager...
item should be grayed out.
• Make sure that the network computer name is defined in Setup’s TCP/IP
Configuration Menu
• The host must be included in Setup’s Internet Host Table, or Domain Name
Service (DNS) must be enabled and configured
• Make sure that /var/dt is writable
• Look at the files $HOME/.dt/startlog and $HOME/.dt/errorlog for any
suspicious messages and correct the indicated problems
• Make sure tftp is enabled on the host
• The directory /usr/dt/config/xfonts/C must be accessible
• Check the gateway and name server addresses
• Check that the network computer name and address do not conflict with
others on the network
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Mr. Forbin.....
guardian

/etc/hosts

This chapter describes the local window managers available on the network
computer. These window managers are: Motif Window Manager (MWM),
OpenLook Window Manager (OLWM), and XP Window Manager (XPWM).

Setting Up Local MWM
Starting local Motif Window Manager (MWM) from your host allows MWM to
access the configuration and resource files in a standard location, for example,
the $HOME directory. It also allows you to customize the window manager
menus and to define menu selections that include host commands. For detailed
information about MWM configuration, refer to the MWM man page located in
/tekxp/man by default.
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Starting Local MWM
Enter the following command in the user’s session start up file.
xpsh -display displayname:0.0 mwm
This assumes that xpsh is in your search path. The default search path is /tekxp/
bin/<host>. You need not specify -display displayname:0.0 if you have set the
DISPLAY environment variable.
NOTE: You can also start local MWM using the remote
configuration file or the Client Launcher. However, these methods
do not allow MWM access to the system-level and user-level
customization files on your host.

Starting MWM With The xp.cnf File
The start and preload commands in the xp.cnf file can be used to start MWM.
For details about these commands, refer to Chapter 2, Remote Configuration in
the Network Computer Reference Manual.

Starting MWM With the Client Launcher
The Client Launcher can be customized to include those clients that you use
most often. If authorized, MWM is listed on the Client Launcher by default as
part of the Window Managers sub-menu. To start MWM, move the mouse
pointer to MWM and click the mouse button. For information about the Client
Launcher, refer to the Client Launcher section in Chapter 4, Local Clients.

Accessing MWM Configuration Files
When starting local MWM using xpsh, using the -access xpsh command line
option enables local MWM to access full resource and file access as if it was
started from a host. For example, the following line starts local MWM and
accesses system-level and user-level customization files on the host:
xpsh -access xpsh mwm

Accessing the MWM Resource Description File
MWM searches for a resource description file in this order:
1. The value of the MWM configFile resource
2. $HOME/$LANG/.mwmrc
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3. $HOME/.mwmrc
4. /usr/lib/X11/$LANG/system.mwmrc
5. /usr/lib/X11/system.mwmrc
If MWM does not find a resource description file in one of the above locations,
it defaults to a language-specific defaults file under the boot directory,
typically, /tekxp/boot/<language>/system.mwmrc. The <language> variable is
determined by the language command in the remote configuration file, or in
Setup. To see the current language setting, enter Setup and look at the
Language option. A sample system.mwmrc file is located in /tekxp/examples/
mwm.

Creating a Local MWM Resource Description File
You can copy the system.mwmrc file to your home directory and then modify
the file to customize your Motif environment. Table 5-1 shows the functions
you can add to the file.
Table 5-1 MWM Functions.
Function

Description

f.beep

Causes a beep

f.cci

Controls the placement and naming of client-command interface (CCI)
commands generated by applications

f.circle_down

Moves the top window to the bottom of the window stack

f.circle_up

Moves the bottom window to the top of the window stack

f.exec or !

Executes the following shell command

f.focus_color

Sets the colormap focus to a window

f.focus_key

Sets the keyboard input focus to a window

f.goto

Moves the root window to a specified location

f.kill

Kills an application and its window

f.lower

Moves a window to the bottom of the window stack

f.maximize

Maximizes a window

f.menu

Activates the named menu. This function can be used to create cascading
and Popup Menus

f.minimize

Iconifies a window

f.move

Starts an interactive move for a window
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Table 5-1 MWM Functions. (Continued)
Function

f.next_cmap

Description

Installs the next colormap

f.next_key

Moves the keyboard input focus to the next window in the window stack

f.nop

Does nothing

f.normalize

Causes an icon or a maximized window to be displayed at its normal size

f.normalize_and_raise Causes an icon or a maximized window to be displayed at its normal size
and raised to the top of the window stack
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f.pack_icons

Reorganizes the icons according to the current icon placement policy

f.pan

Moves the root window a specified amount

f.pass_keys

Toggles the use of special key bindings

f.post_wmenu

Posts the Window Menu

f.prev_cmap

Installs the previous colormap in the list of colormaps for the window with
the colormap focus

f.prev_key

Moves the keyboard input focus to the previous window in the window
stack

f.quit_mwm

Exits the window manager without exiting the X Window System

f.raise

Raises a window to the top of the window stack

f.raise_lower

If obscured, raises a window to the top of the window stack; otherwise,
lowers it to the bottom of the window stack

f.refresh

Redraws all the windows on the screen

f.refresh_win

Redraws a single window

f.resize

Starts an interactive resize for a window

f.restart

Stops and restarts the window manager

f.restore

Restores an iconified window to its previous state

f.restore_and_raise

Restores an iconified window to its previous state and raises it to the top
of its stack

f.screen

Moves a pointer to a specific screen

f.send_msg

Sends a client message to the application

f.separator

Draws a separator in a menu pane

f.set_behavior

Restarts the window manager with the default behavior or reverts to any
custom behavior

f.title

Inserts a title in a menu pane

f.track_pan

Continuously moves the root window in the direction of the mouse
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Accessing the MWM Defaults File
MWM is configured from its resource database. This database is built from the
following sources, listed in the order that MWM accesses them.
1. MWM command line options
2. File specified by the XENVIRONMENT environment variable, if it set;
otherwise
$HOME/.Xdefaults-terminal_name, if it exists
These values do not override the existing values in the database.
3. RESOURCE_MANAGER root window property, if it is set;
otherwise
$HOME/.Xdefaults, if it exists
The RESOURCE_MANAGER is typically set with the xrdb command.
These values do not override the existing values in the database. An example
.Xdefaults file is shown in Example 5-1.
4. The user’s application specific app-defaults file;
$HOME/$LANG/Mwm, if it exists;
otherwise
$HOME/Mwm
The actual location of this file depends on the XUSERFILESEARCHPATH
and XAPPLRESDIR environmental variables. These values do not override
the existing values in the database.
5. The application’s specific app-defaults file;
/usr/lib/X11/$LANG/app-defaults/Mwm, if it exists;
otherwise
/usr/lib/X11/app-defaults/Mwm
The actual location of this file depends on the XFILESEARCHPATH
environmental variable. These values do not override the existing values in
the database.
If none of the above application specific app-defaults files are found, MWM
defaults to a language-specific defaults file from the boot configuration
directory, typically, /tekxp/boot. The language is specified by the Language
command in the remote configuration file (xp.cnf), or in Setup. To see the
current language setting, enter Setup and look at the Language option.
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Example 5-1 Example .Xdefaults File.
! For the monochrome (or 4 bit plane=16 color/grey) device,
! decorations are shaded with pixmaps.The window title is
! reverse video to improve visibility.
#if PLANES > 4
Mwm*menu*background
#d4d8e8
Mwm*menu*foreground:
Black
Mwm*background:
#7c8498
Mwm*foreground:
#fce089
Mwm*activeForeground:
#ffff00
Mwm*activeBackground:
#9db5cd
#else
Mwm*bitmapDirectory:
/usr/include/X11/bitmaps
Mwm*bottomShadowColor:
Black
Mwm*topShadowColor:
White
Mwm*activeBottomShadowColor:
Black
Mwm*activeTopShadowColor:
White
Mwm*background:
Black
Mwm*client*backgroundPixmap:
flipped_gray
Mwm*activeBackground:
White
Mwm*activeBackgroundPixmap:
gray
Mwm*foreground:
White
Mwm*client*foregroundPixmap:
flipped_gray
Mwm*activeForeground:
Black
Mwm*activeForegroundPixmap:
gray
Mwm*iconImageBackground:
Black
Mwm*iconImageForeground:
White
Mwm*iconImageBottomShadowPixmap:flipped_gray
Mwm*iconImageTopShadowPixmap:
flipped_gray
#endif
Mwm*buttonBindings:
DefaultButtonBindings
Mwm*clientDecoration:
all
Mwm*clientAutoPlace:
True
Mwm*frameBorderWidth:
5
Mwm*iconAutoPlace:
True
Mwm*iconClick:
False
Mwm*iconBoxGeometry:
6x1+0-0
Mwm*iconDecoration:
image label
Mwm*iconFrameBorderWidth:
20
Mwm*iconPlacement:
bottom left
Mwm*iconPlacementMargin:
10
Mwm*interactivePlacement:
False
Mwm*keyBindings:
DefaultKeyBindings
Mwm*passSelectButton:
True
Mwm*resizeBorderWidth:
8
Mwm*showFeedback:
all
Mwm*systemButtonClick:
False
Mwm*systemMenu:
DefaultRootMenu
Mwm*useIconBox:
True
Mwm*windowMenu:
DefaultWindowMenu
Mwm*cleanText:
True
Mwm*saveUnder:
True
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Accessing Bitmap Files
The MWM iconImage and bitmapDirectory resources are used to specify paths
to bitmap files. The default value for bitmapDirectory is the /usr/include/X11/
bitmaps directory. To access a bitmap file star in your $HOME directory, the
iconImage resource can be set in your $HOME/.Xdefaults file as follows:
Mwm*program_name*iconImage:

~/star

Specifying Virtual Key Bindings
MWM reads the $HOME/.motifbind file, if it exists, to install a virtual key
bindings property on the root window. Example motif bindings files are
installed in the /tekxp/examples/mwm directory by default.

Setting up Virtual Desktop Panning
The Virtual Desktop Panning feature is available with MWM 2.0. This section
provides an example of how you can modify your .Xdefaults and .mwmrc files
to activate virtual panning in MWM. The MWM functions f.pan, f.goto, and
f.track_pan need to be bound either to keys or to mouse buttons.

Editing .mwmrc for Virtual Desktop Panning
Add the following to your .mwmrc file to use virtual panning. Make sure that
the name of the button bindings match the name given for the resource value
Mwm*buttonBindings in your .Xdefaults file.
Buttons
{
<Btn2Down>
Meta<Btn1Down>
}

MyButtonBindings

Keys
{

MyKeyBindings

Meta<Key>Up
Meta<Key>Down
Meta<Key>Left
Meta<Key>Right
}

root
root

window|root
window|root
window|root
window|root

f.menu GotoMenu
f.track_pan

f.pan
f.pan
f.pan
f.pan

0,-100
0,100
-100,0
100,0
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To set up a menu that lets you quickly switch to different locations on the virtual
desktop, enter the following. Then restart MWM.
Menu
{
Up-Left
Up
Up-Right
Left
Home
Right
Down-Left
Down
Down-Right
}

GotoMenu
f.goto
f.goto
f.goto
f.goto
f.goto
f.goto
f.goto
f.goto
f.goto

1500,1100
0,1100
-1500,1100
1500,0
0,0
-1500,0
1500,-1100
0,-1100
-1500,-1100

Editing .Xdefaults for Virtual Desktop Panning
Add the following to your .Xdefaults file to keep MWM from moving all your
windows back to the visible part of the screen at startup:
Mwm*positionOnScreen:

False

Note that it is important to set the positionOnScreen resource to False because
MWM automatically repositions all off-screen windows back to the display
screen on restart.
To set up a menu to go to preset positions on the virtual canvas, add the
following lines:
Mwm*GotoMenu*numColumns:
Mwm*GotoMenu*packing:
Mwm*GotoMenu*orientation:
Mwm*GotoMenu*alignment:

3
PACK_COLUMN
HORIZONTAL
ALIGNMENT_CENTER

For consistency with the .mwmrc file, add the following lines:
Mwm*buttonBindings:
Mwm*keyBindings:

MyButtonBindings
MyKeyBindings

To prevent the client and icon windows from moving, add the following lines:
Mwm*XBiff*iconPinned:
Mwm*XBiff*clientPinned:
Mwm*iconPinned:
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Troubleshooting MWM
This section contains some information on possible solutions to correct some
common MWM problems:
• If MWM does not come up at all:
- Your DISPLAY environment variable may not be set correctly. The
DISPLAY environment variable may be set to unix:0, as in a
configuration file such as $HOME/.cshrc. You may see output directed to
your host display, instead of to the network computer.
- Your local MWM authorization key may not be entered. To check your
enabled options, press Setup. Drag on Statistics and release on Options. If
mwm is not there, enter the correct authorization key at the Boot Monitor.
Refer to Chapter 4, Boot Monitor of the Network Computer Reference
Manual.
- If you start MWM with xpsh and it fails to execute clients from the MWM
menus, make sure that the path to the client is in the xpsh environment.
- Check the console window for a message indicating that there is not
enough memory to run MWM. Increase the amount of available memory
if necessary.
• If you customize a file which is read by local MWM but the changes are not
reflected when you run MWM:
- Make sure the customized file has world read permissions.
- If the file is accessed using TFTP, make sure you are using the version of
xpsh included with the software version 6.1 or greater. If you are using an
earlier version of xpsh, enter your hostname in the Internet host table.
• Do not kill an xpsh process that invoked MWM with a -9 (SIGKILL) signal.
Neither MWM nor xpsh can clean up before they exit. Use kill -15
(SIGTERM) instead.
• If your keyboard has neither a Meta key nor an Alt key, use the xmodmap
command to display and modify the values of mapped keys, including the
key mapped to mod1, which MWM uses for Meta or Alt.
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Starting OLWM With The xp.cnf File
The start and preload commands in the xp.cnf file can be used to start OLWM.
For details about these commands, refer to Chapter 2, Remote Configuration in
the Network Computer Reference Manual.

Starting OLWM With the Client Launcher
The Client Launcher can be customized to include those clients that you use
most often. If authorized, OLWM is listed on the Client Launcher by default as
part of the Window Managers sub-menu. To start OLWM, move the mouse
pointer to OLWM and click the mouse button. For information about the Client
Launcher, refer to the Client Launcher section in Chapter 4, Local Clients.
When starting local OLWM using xpsh, using the -access xpsh command line
option enables OLWM to access full resource and file access as if it was started
from a host. For example, the following line starts local OLWM and accesses
system-level and user-level customization files on the host:
xpsh -access xpsh olwm
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Setting Up XP Window Manager
XP Window Manager (XPWM) is a local window manager available with the
network computer. XPWM provides a basic window manager that uses a
minimum amount of network computer memory.

Accessing the XPWM Defaults File
XPWM is configured from its resource database. This database is built from the
following sources, listed in the order that XPWM accesses them (the last setting
takes precedence over the first).
1. RESOURCE_MANAGER root window property, if it is set
The RESOURCE_MANAGER is typically set with the xrdb command.
These values do not override the existing values in the database.
2. The application’s specific app-defaults file;
/usr/lib/X11/<language>/app-defaults/xpwm
3. XPWM default values

Starting the XpressWare Window Manager
XPWM can be started with xpsh, from the remote configuration file (xp.cnf),
or from the Client Launcher.

Starting XPWM With xpsh
Enter the following command in the user’s session start up file.
xpsh -display displayname:0.0 xpwm
This assumes that xpsh is in your search path. The default search path is /tekxp/
bin/<host>.
NOTE: You need not specify -display displayname:0.0 if you have set
the DISPLAY environment variable.

Starting XPWM With the xp.cnf File
The start and preload commands in the xp.cnf file can be used to start XPWM.
For details about these commands, refer to Chapter 2, Remote Configuration in
the Network Computer Reference Manual.
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Starting XPWM With the Client Launcher
The Client Launcher can be customized to include those clients that you use
most often. The XPWM is listed on the Client Launcher by default as part of
the Window Managers sub-menu. To start XPWM, move the mouse pointer to
XPWM and click the mouse button. For information about the Client Launcher,
refer to the Client Launcher section in Chapter 4, Local Clients.

Using XPWM
You use XPWM much like any other window manager. The windows have
many of the same elements as Motif Window Manager and OpenLook Window
Manager. Figure 5-1 shows a sample XPWM window and its elements.

Window Name
Iconify
Button

Title Bar

Resize Button

xterm
eagle>

Scroll Bar

Window with
Input Focus

TEK

TEK

Icon

xterm

8049-144

Figure 5-1 Elements of an XPWM Window
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You can move and resize windows using either the mouse alone, or the
commands located on the XPWM menu. Table 5-2 shows the mouse interface.
Table 5-2 Working With XPWM Windows.
To

Do This

Move a window

Position the mouse pointer on the title bar, click and drag
the window to the new position

Resize a window

Click on the Resize button and drag the window to the new
size

Make a window active

Position the mouse pointer on the title bar and click

Iconify a window

Click on the Iconify button

Un-iconify a window

Click on the window’s icon

Raise a window to the top Position the mouse pointer in the window and click

To access the XPWM menu, position the mouse pointer outside of a window,
and click. First select a command, and then move the mouse pointer to the
window you want the command to affect. Table 5-3 shows the commands
available on the XPWM menu.
Table 5-3 XPWM Menu Commands.
Command

Description

Iconify

Iconify a window

Resize

Resize a window

Move

Move a window

Raise

Move a window to the top of other windows

Lower

Move a window behind other windows

Icon Manager

Open the icon manager, which lists the open windows and
applications on the screen

Kill

Close a window and any processes running in the window

Delete

Close a secondary window, such as a dialog box for an application.

Restart XPWM

Exit and restart the XpressWare Window Manager. Open windows
and processes will remain while the window manager restarts.

Exit XPWM

Exit the XpressWare Window Manager
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Customizing XPWM
You can change the appearance of XPWM using the resource settings listed in
Table 5-4. XPWM does not allow user-defined bindings or user-defined menus.
Table 5-4 XPWM Resource Settings.
Resource

Description

xpwm.IconForeground <color>

Specifies foreground color of icons

xpwm.IconBackground <color>

Specifies background color of icons

xpwm.IconFont <font>

Specifies the font used with icon names

xpwm.TitleForeground <color>

Specifies the foreground color of the title bar

xpwm.TitleBackground <color>

Specifies the background color of the title bar

xpwm.TitleFont <font>

Specifies the font used in the title bar

xpwm.MenuForeground <color>

Specifies the foreground color of the XPWM menu

xpwm.MenuBackground <color>

Specifies the background color of the XPWM menu

xpwm.MenuFont <font>

Specifies the font used in the XPWM menu

xpwm.BorderWidth <integer>

Specifies the width of the border around the windows

xpwm.BorderColor <color>

Specifies the color of the borders around the windows

xpwm.BorderHighlightColor <color> Specifies the border highlight color
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xpwm.IconPosition <position>

Specifies the icon position

xpwm.InteractivePlacement <state>

Specifies whether placement is interactive or static (true/
false)

xpwm.InputFocus <method>

Specifies the method used by the mouse to activate a
window. Enter either click or point.
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S..FONTS..
NT

This chapter describes how to set up fonts on the host to support entries added
in the remote configuration file and the fonts.tbl file. The network computers
use PCF format as standard, but can read SNF, SCF, SNF.Z, PCF, PCF.Z,
PCFZ, BDF, DECW$FONT, and many compressed formats.
The font access method is specified in the remote configuration file. The
network computer can access fonts via TFTP, NFS, DAP, or SXp. Font files
tend to be large; they do not have to be installed on the same disk as the boot
files.
NOTE: SXp is optional. Refer to your SXp User Manual for
information on setting up SXp as a host access method.
If you use NFS as the file access method, the fonts can be placed anywhere in
the host file system, with NFS directories and exports set accordingly. Use an
nfs_table command or add an nfs.tbl entry, and enable NFS access.
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How the X Server Builds the Font Database
At boot time, the X server builds a font database based on the following
sequence of events:
1. The X server searches the primary path for a fonts.tbl file.
If a fonts.tbl file is not found with the primary path, the X server searches the
secondary path for a fonts.tbl file. The secondary path is used if the primary
path is not specified. Primary and secondary paths are specified in either the
remote configuration file or in Setup. If fonts are not found through the
primary or secondary paths, the X server searches the boot host and the boot
method.
In this example, the primary file path for the configuration files is
\tekxp\boot\fonts on the host arizona, accessed with NFS. The
file_host_name is not needed for NFS, but is specified as a null string to
ensure a correct pate.
ip_host_table
file_access_1
file_host_name_1
file_path_1

"128.07.60.12" "arizona"
NFS
""
"/tekxp/boot/fonts"

In this example, the secondary file path for the configuration files is
\usr\tekxp\boot\fonts, where \usr\tekxp\boot\fonts is an exported directory
from the host oregon and accessed through NFS. The file_host_name is not
needed for NFS, but is specified as a null string to ensure a correct path.
file_access_2
file_host_name_2
file_path_2

NFS
""
"/usr/tekxp/boot/fonts"

This example assumes that you have an entry similar to the following in the
nfs.tbl file:
arizona: /tekxp/boot/fonts /tekxp/boot/fonts
oregon:/usr/tekxp/boot/fonts/usr/tekxp/boot/fonts
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2. When the X server finds a fonts.tbl file, it searches the directories listed in
this file for fonts.dir and fonts.alias files. The X server uses the information
in the fonts.dir and fonts.alias files to search for specific font files. The X
server rejects the path unless it finds both fonts.dir and fonts.alias files.
NOTE: Once the fonts.tbl file is found, the X server ignores
file_path_1 and file_path_2 when searching for specific font files.
The fonts.dir file maps file names to an X logical font descriptive name
(XLFD); the fonts.alias file lists alternative names for the XLFD font names.
A typical entry for fonts.dir is:
5x8.snf -misc-fixed-medium-r-normal--8-80-75-75-c-50-iso8859-1

Typical entries for fonts.alias are:
FILE_NAMES_ALIASES
5x8 -misc-fixed-medium-r-normal--8-80-75-75-c-50-iso8859-1

3. The network computer resolves font paths in this order:
a. Primary access and font path
b. Secondary access and font path
c. Boot host and boot method
Access can be a host if using TFTP or DAP as the access method, or a mount
point if using NFS. If not resolved, the font path is rejected.
4. Resident fonts are always available unless explicitly removed with the
xset fp- command. Refer to Table 6-1 for the list of resident fonts.
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Resident and Boot Directory Fonts
Resident fonts (Table 6-1) are loaded with the X server, and are always
available unless preceded by a fonts.dir or fonts.alias file entry. Boot directory
fonts (Table 6-2) are loaded from the installation media into the directory
\tekxp\boot.
Table 6-1 Resident Fonts.
Font

X Logical Font Description Name (XLFD)

6x10

-misc-fixed-medium-r-normal--10-100-75-75-c-60-iso8859-1

6x13

-misc-fixed-medium-r-semicondensed--13-120-75-75-c-60-iso8859-1

6x13B

-misc-fixed-bold-r-semicondensed--13-120-75-75-c-60-iso8859-1

8x13

-misc-fixed-medium-r-normal--13-120-75-75-c-80-iso8859-1

8x13B

-misc-fixed-bold-r-normal--13-120-75-75-c-80-iso8859-1

9x15

-misc-fixed-medium-r-normal--15-140-75-75-c-90-iso8859-1

9x15B

-misc-fixed-bold-r-normal--15-140-75-75-c-90-iso8859-1

LucidaV2RT10

-bigelow & holmes-lucidav2-medium-r-normal-typewriter-16-100-100100-m-80-iso8859-1

cursor

cursor

Table 6-2 Boot Directory Fonts.
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Font

X Logical Font Description Name (XLFD)

term14_100

-bitstream-terminal-medium-r-normal--18-140-100-100-c-110-iso8859-1

term14_75

-dec-terminal-medium-r-normal--14-140-75-75-c-80-iso8859-1

luBS14

-b&h-lucida-bold-r-normal-sans-14-140-75-75-p-92-iso8859-1

luRS12

-b&h-lucida-medium-r-normal-sans-12-120-75-75-p-71-iso8859-1

helvB12

-adobe-helvetica-bold-r-normal--12-120-75-75-p-70-iso8859-1

olcursor

-sun-open look cursor-----12-120-75-75-p-160-sunolcursor-1

olgl12

-sun-open look glyph-----12-120-75-75-p-113-sunolglyph-1

LuciB10

-bigelow & holmes-lucida-bold-r-normal-serif-14-100-100-100-p97iso2022_r_tek-l442r433

LuciBT10

-bigelow & holmes-lucida-bold-r-normal-typewriter-16-100-100-100-m80iso2022_r_tek-l442r433
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Table 6-2 Boot Directory Fonts. (Continued)
Font

X Logical Font Description Name (XLFD)

LuciRT10

-bigelow & holmes-lucida-r-normal-typewriter-16-100-100-100-m80iso2022_r_tek-l442r433

techB14

-bitstream-terminal-bold-r-normal--18-140-100-100-c-110-dec-dectech

deccurs

decw$cursor

decsess

decw$session

fg-22

fg-22

timr10

-adobe-times-medium-r-normal-10-100-75-75-iso8859-1

timr24

-adobe-times-medium-r-normal--24-240-75-75-p-124iso8859-1

luBS12

-b&h-lucida-bold-r-normal-sans-12-120-75-75-p-79-iso8859-1

LuciV2RT12

-bigelow & holmes-lucidav2-medium-r-normal-typewriter-21-120-100-100m-100-iso8859-1

LuciV2NT12

-bigelow & holmes-lucidav2-medium-r-condensed-typewriter-21-120-100100-m-100-iso8859-1

tekdw132

tekdw132

tekdw80

tekdw80

tekdwdhb80

tekdwdhb80

tekdwdht80

tekdwdht80

tekdwhb132

tekdwhb132

tekdwht132

tekdwht132

tktrm132

tktrm132
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Installing Fonts
The installation media provides fonts.dir and fonts.alias files for each font
directory listed in Table 6-3, although you may have to add the names of these
directories to the fonts.tbl file. To install additional PCF, SCF, SNF or other
directly supported fonts:
1. Make a directory for your font files, for example, myfonts
2. Copy the additional fonts in the myfonts directory
3. If the fonts are compressed (ending in .Z), you can uncompress them for
faster reading, or leave them compressed to save disk space. To use
uncompress:
# uncompress *

4. Run mkfontdir to create a fonts.dir file. Enter:
# mkfontdir myfonts

NOTE: A modified version of /tekxp/src/mkfontdir reads inverted
SNF files. You must make the utility before you can use it.
5. Use an editor to create the fonts.alias file. You can include the keyword
FILE_NAMES_ALIASES to indicate you are mapping the file name to the
alias. Add the aliases and the font logical names to the file.
NOTE: The fonts.alias file must exist, even if it is empty.
Refer to the mkfontdir man page for more information.
6. Edit \tekxp\boot\fonts\fonts.tbl and add the new font path.
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Table 6-3 lists the font directories in the \tekxp\boot\fonts directory.
Table 6-3 Font Directories Available on the Installation Media.
Directory

Source, Contents, Application

misc

Cursor and character fonts, MIT miscellaneous fonts

100dpi

X Consortium distribution for 100 dot-per-inch fonts. Some fonts contain
eight-bit multinational character sets.

75dpi

X Consortium distribution for 75 dot-per-inch fonts. Some fonts contain
eight-bit multinational character sets.

tek100dpi

Tektronix-distributed Lucida fonts.

oldx11

X Consortium distribution fonts, including fonts released prior to X
Version 11, Release 3.

openlook

OPEN LOOK applications fonts.

japanese

Japanese fonts.

Speedo

Speedo fonts from Bitstream, Inc.

Type1

Courier (typewriter) font from IBM Corporation
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Troubleshooting
This chapter contains information to help solve problems when booting and
using your network computer. Table 7-1 lists identified problems and the page
numbers to locate possible solutions.
Table 7-1 Possible Problems.
Problem

Page #

Boot host does not respond

7-2

Network computer does not respond to a ping

7-3

Duplicate IP address message

7-3

Network computer can not locate os file

7-3

Network computer can not locate .tbl files

7-4

Network computer can not locate font files

7-4

TekHostMenu does not display any xdm hosts

7-4

xdm login window does not appear

7-5

xdm login window reappears instead of starting session

7-5

Control-C does not cause an interrupt

7-5
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Boot host does not respond
• Verify that the boot host is configured to support the boot method you
selected. Supporting host files may include inetd.conf, bootptab, exports,
hosts, and ethers.
• Use the ps command on the boot host to verify the supporting daemon(s) are
running. The daemons may include: inetd, nfsd, tftpd, bootpd, and rarpd.
• If you are booting from NVRAM, use the network computer Boot Monitor
to verify the correct values are assigned for the following commands:
- Network computer IP address (iaddr) or node number (dnode)
- Boot host IP address (ihost)
- Subnet mask (imask)
- Gateway address (igate)
- Boot method (bmethod)
- Boot path (bpath)
- Boot from (bafrom set to NVRAM)
• If you are booting from NETWORK, use the network computer Boot
Monitor to verify the correct values are assigned for the following
commands:
- Boot method (bmethod)
- Boot from (bafrom set to NETWORK)
• Use the network computer Boot Monitor to ping the boot host. If the host
does not respond, use the ifconfig command on the host to verify the host’s
subnet mask and gateway address. The ifconfig command is also used to
change the subnet mask and gateway address if necessary.
• If the host has an ethernet switch, make sure it is set to the proper position
for thicknet or thinnet.
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Network computer does not respond to a ping
• Verify that the network computer is booted.
• Use the network computer Boot Monitor report command to check the
network computer’s ethernet switch or jumper setting. If it is incorrect, refer
to the pictorial physical installation guide for your network computer model.
Duplicate IP address message
This can indicate two different problems: either there are two devices using the
same IP address, or there is a mismatch between the ethernet and IP addresses
in the host files or in the router ARP tables.
• To determine if there are two devices using the same IP address, go to a
different device and ping the duplicate IP address. If two responses come
back, change the IP address on one of the devices. Be sure to save the new
address. You may also have to change supporting files on the host, such as
/etc/hosts, /etc/ethers, bootptab, and change entries in the ARP table (arp
command) to ensure the correct ethernet and IP addresses are used.
• If the network computer is using the same IP address as a previous device
(that has been removed from the network), then the problem is a mismatch
between the ethernet and IP addresses. To correct this situation, change the
files where the ethernet and IP addresses are used, such as /etc/ethers,
bootptab, and change entries in the ARP table (arp command). The network
administrator should flush the ARP table in the router.
Network computer can not locate os file
• Verify that the boot path is specified correctly and matches the actual file
location on boot host. If using secure tftp, the secure directory should not be
specified as part of the boot path. For Silicon Graphics hosts, the secured
boot path should not have a leading slash. For other UNIX hosts, the secured
boot path should have a leading slash.
• Verify that you are using the correct os file (os.10, os.330, or os.350), and that
it has world read permission. Use chmod command to change permission.
• On Hewlett-Packard hosts, verify that tftp is set up properly. On some
Hewlett-Packard hosts, there must be a tftp entry in the password file. The
secure directory is specified in the password file as if it were a home
directory. Also, if tftp is in the inetd.sec file, make sure the network computer
is listed as an authorized device.
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Network computer can not locate .tbl files
Verify the primary and secondary file hosts, access methods, and paths:
• If you are debugging a centralized system, or if the network computer is not
booted, check the primary and secondary file_access, file_host_name, and
file_path entries in the xp.cnf file.
• If the network computer is booted, use the Console window to see the host,
method, and path the network computer tried. Use the Left and Right mouse
buttons to scroll through the window. You can also use Setup to view the host
file access information.
• Verify that the appropriate daemon is running on the host for the specified
access method.
• Verify that the .tbl files are in the proper location and have world read
permission. If you are using secure tftp, ensure that the .tbl files are in the
secure directory. If the .tbl files are not in the secure directory, either move
them to the secure directory or use NFS to download them.
Network computer can not locate font files
• Follow the previous procedures for Network computer can not locate .tbl
files to verify that the network computer is locating the fonts.tbl file.
• Verify that the fonts.tbl file specifies the correct paths to the font directories.
If NFS is used, the full pathname to the NFS mount point must be specified
if NFS is used.
• Verify that the fonts.dir and fonts.alias files exist and are readable.
• Verify that the fonts.dir and fonts.alias files contain the correct paths to the
actual font files.
TekHostMenu does not display any xdm hosts
• Use the ps command to verify that the xdm daemon is running on the host.
• Check the Host Connect Method with Setup. Drag on Configuration
Summaries and release on X Environment. Verify that the Host Connect
Method is set to TekHostMenu.
• Verify that the xdm-error and xdm-pid files have world write permission in
the xdm-config file.
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xdm login window does not appear
• Use the ps command to verify that the xdm daemon is running on the host.
• Check the Host Connect Method with Setup. Drag on Configuration
Summaries and release on X Environment. Verify that the Host Connect
Method is set to XDMCP Direct, and that the log in host is specified.
• Verify that the xdm-error and xdm-pid files have world write permission in
the xdm-config file.
xdm login window reappears instead of starting session
• Verify that the X startup file contains a valid session control client. Ensure
that either the system-wide Xsession (or Xinitrc on Sun hosts) or users
.xsession (or .xinitrc on Sun hosts) file ends with a client that is not running
in the background. Verify the path to the session control client.
To correct the problem, try using failsafe mode: When the xdm login
window appears, type in user name and password and press the F1 key
(instead of Enter). If nothing happens, then the failsafe feature is not enabled
on that host, and you must log in by another method.
• Verify that the session control client is executable. Use the chmod command,
if necessary, to make the session control client executable. Try using failsafe
mode to correct the problem.
• The X startup file may not be executable. Use the chmod command, if
necessary, to make the X startup file executable. Try using failsafe mode to
correct the problem.
• Environmental variables may not be set. Verify that the X startup file sets any
environmental variables that are required by the session control client. Try
using failsafe mode to correct the problem.
Control-C does not cause an interrupt
• Set the interrupt variable in each user’s .cshrc (c shell) or .profile (Bourne
shell) file. Use the format:
stty intr ’^C’
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